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Kirisiw

Oqıtıw processinde multimedia - bul informatikanıń programmalıq hám

texnikalıq quralları járdeminde audio - video, tekst, grafika hám animaсiya effektleri

tiykarında oqıw materialların oqıwshılarǵa jetkerip beriwdiń ulıwmalasqan haldaǵı

kórinisi. Házirgi kompakt CD,DVD hám Blu-ray tipindegi disklerde

maǵlıwmatlardıń sıyımlılıǵı 25 - 50 Gb tı quraydı. Olardıń ishine birqansha ámeliy

hám sistemalı programmalar, ilmiy xabarlar hám maqalalar, hújjetler toplanǵan

maǵlıwmatlardı saqlaw múmkin. Endi disklerde oqıw hújjetlerine tayar súwretler,

tekstler, audio jazıwlar, video kórinislerdi kiritiw birqansha ańsat.

Multimedia oqıw resursları jaratıwda bul disklerden paydalanıw oqıw processin

jetilistiriwge járdem beredi. CD-ROM toplaǵıshlarınıń bir kemshiligi bul qattı

disklerge qaraǵanda ásten háreketleniwsheńligi bolıp esaplanadı. Multimedia oqıw

resursları programması járdeminde oqıtıwda  awızsha sózdi tıńlaw hám aytılıwın,

sóylewin qadaǵalaw ushın video hám audio disklerden, sonday-aq matematikalıq

qaǵıydaları berilgen esabatlardı alıp barıwda paydalanıwǵa boladı. Oqıtıwdı

multimedia oqıw resursları járdeminde alıp barıw oqıtıw  processiniń sıpatın asıradı.

Usı magistrlik dissertaciya jumısında multimedia oqıw resursların mektepte

oqıtılatuǵın pánlerge, hujjetlerge engiziw hám paydalaniw metodikasın islep shıǵıw

máselelerin qaraymız.

Mektepte oqıtıw processin avtomatlastırıwda elektron mektep jaratıw házirgi

dáwirde zamanagóy mashqala esaplanadı. Sonıń ishinde elektron kúndelik, elektron

tabel, elektron tetrad hám elektron jurnal jaratıw hám olardı ámelde paydalanıw

metodikasın islep shıǵıw qaraladı. Joqarıdaǵı aytılǵanlardı esapqa alıp magistrlik

dissertaciya jumısı temasınıń házirgi waqıtta zamanagóy hám aktual ekenligin

kórsetemiz.

Temanıń aktuallıǵı. Jáhánge názer salatuǵın bolsaq kompyuter grafikası hám

dizayn júda hám  keń dárejede rawajlanǵan. Olardı ámelde kópten beri

qollanılmaqta. Biraq bul jaratılǵan bárshe dásturler, rolikler, dizaynlerdıń tiykarǵı

bólimi kinofilmler, multfilmler, web-saytlar ushın  jaratılmaqta.   Arnawlı saytlarda
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pánlerge temaǵa sáykes multimedialı sabaqlıqlardıń kemligi, barları hám anıq bir

pánniń temaların tolıq jarıtıp bere almaslıǵı talim salasına jánede kóbirek dıqqat

beriw lazımlıǵın kórsetedi.  Lekin elektron sabaqlıqlar ishine kiritilgen tekstli

jazıwlar, suwretlerden házirde grafikanıń eń zamanagóy jónilisi bolǵan roliklerdiń

jaratılıwı saytlarǵa  hám soǵan tiyisli bolǵan nárselerge qızıǵıwdı asıradı. Bul

tarawda kóp jumıslar ámelge asırılǵan. Sabaqlardı  multimedia imkaniyatlarinan

paydalanıp  ótiliwi oqıtıwshılarǵa bir qansha qolaylıqlar jaratadı. Sebebi sol pánniń

temalarına dawıslı dastúrler, suwretli islenbeler, háreketli jazıwlar yamasa

prezentaciyalar, multiplikaciya kóriniside jaratılǵan filmler, animaciyalar bir

tárepten oqıtıwshı ushın jańalıq bolsa, ekinshi tárepten tálim alıwshılar ushın

qızıǵarlı hám dıqqatın ózine qaratadı. Bul temanı jaqsı ózlestiriwge túrtki boladı.

Anıq bir multimedia oqıw resursların islep shıǵıw mútájligine sáykes

keliwshi (adekvat) dástúrlerdi tańlaw hám olardan multimedia oqıw resursların

proektlestiriwde paydalanıw ushın bar bolǵan proektlestiriw quralların tereń  analiz

etiw hám klassifikaсiyalaw zárúrligi, multimedia quralları tiykarında  oqıwshılarǵa

tálim beriw hám bilim sıpatın jetilistiriwdi jolǵa qoyıw usı jumıstıń aktuallıǵın tolıq

sıpatlap beriledi.

Jumıstıń maqseti hám wazıypaları. Magistrlik dissertaсiya jumısında

multimedia elektron oqıw resursların jaratıw metodikası jeke kompyuter bazasında

jaratıw máseleleri qaraladı. Bunıń ushın magistrant tárepinen multimedia elektron

oqıw resurslarına tiyisli obektlerdi analizlew, multimedia hám onıń texnik-dastúriy

quralların anıqlaw, kompyuter grafikası hám onıń turleri menen tanısıw, multimedia

elektron oqıw resursların jaratıw metodikası járdeminde programmalı resurslardı

paydalanıw múmkinshiliklerin izertlew, sonday-aq, anıq obekt ushın elektron oqıw

resursların jaratıwdı proektlestiriw metodikasın islep shıǵıw hám onı

ulıwmalastırıw jumıstıń tiykarǵı maqseti esaplanadı. Bunıń ushın tómendegi

waziypalardı  orınlaw kerek: obektti analizlew, multimediaǵa tiyisli programmalar

hám olar arasındaǵı baylanıslardı   anıqlaw, xabar sxemaların dúziw, maǵlıwmatlar

bazası sisteması ushın xabar sxemaların proektlestiriw, elektron kúndelik, elektron

tabel, elektron tetrad hám elektron jurnal jaratıw hám olardı ámelde paydalanıw
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metodikasın islep shıǵıw. Bunıń ushın mektep kóleminde maǵlıwmatlar bazasın

tańlaw, maǵlıwmatlar modelin dúziw, maǵlıwmatlardı manipulyaсiyalaw,

programmalıq resurslardıń sxemasına sáwlelendiriw.

İzertlew obekti hám predmeti. İzertlew obekti bolıp Windows XP operaсion

sisteması qabıq programmalarınan paydalanıp mektep kóleminde multimedialı

elektron oqıw resursların jaratıw, atap aytqanda elektron kúndelik, elektron tabel,

elektron tetrad hám elektron jurnal jaratıw hám olardı ámelde paydalanıw

texnologiyası qaraladı. Usı obektlerdiń dúzilisi, informaсiyalardıń qozǵalısı, tayar

informaсiyaǵa bolǵan talaplar hám usınıslar, mekteptiń oqıw resursları izertlew

predmeti esaplanadı.

İzertlew metodikası hám usılları. İzertlewdi alıp barıwda mámleketimiz

tárepinen islep shıǵılǵan pármanlar, qararlar hám normativ hújjetlerden

paydalanıldı. Sonday-aq, magistrlik dissertaсiya jumısın orınlawda sistemalı

jandasıw bolıp , izertlew obektin analizlew hám sintezlew usılları paydalanıldı.

İzertlew nátiyjeleriniń ilimiy tárepten jańalıq dárejesi. Jumısta tiykarǵı

jańalıq bolıp elektron kúndelik, elektron tabel, elektron tetrad hám elektron jurnal

jaratıw hám olardı ámelde paydalanıw metodikası qaraladı. Bunıń ushın multimedia

elektron oqıw resursların jergilikli jaǵday ushın proektlestiriw hám qáliplestiriw

texnologiyası  islep shıǵıldı.

İzertlew nátiyjeleriniń ámeliy áhmiyeti hám qollanılıwı. Alınǵan

nátiyjelerdiń ámeliy áhmiyeti mektep, kolledj, akademik liсey hám joqarǵı oqıw

orınları studentleri ushın, sonday-aq, ilimiy izleniwshiler, aspirantlar, magistrler

ushın multimedia elektron oqıw resursların jaratıw boyınsha metodikalıq kórsetpe

retinde paydalanıwǵa boladı. Aralıqtan bilim beretuǵın oqıw orınları, oqıshılardıń

bilim alıw sapasın, sabaqqa qatnasın, oqıw jılında úlgeriwin, oqiw wazıpaların

orınlaw dárejesin, baqlaw jumısların alıp baradı, ata-analardıń aralıqtan oqıwshı

ballarınıń bilimin anıqlawın jetilistiriwge qollanıwǵa boladı.
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Jumıstıń dúzilisi. Jumıs kirisiw, tiykarǵı úsh bólim hám qosımshadan  turadı.

Dissertaсiya jumısınıń birinshi babı Multimedia hám onıń texnik-dastúriy

quralları atamasında bolıp, onda multimedia túsinigi, multimedia elektron oqıw

resursları, interaktiv tálim usılları kórip shıǵılǵan hám juwmaqlaw keltirilgen.

Ekinshi bap Kompyuter grafikası hám  onıń túrleri atamasında bolıp, tómendegi

máseleler qaraldı:  Adobe Phoroshop dastúri hám onıń imkaniyatları ,  Rastrlı grafik

redaktorında kórinis jaratıw hám olarǵa islew beriw,  Adobe Photoshop dástúrinde

reńler hám tekstler menen islew, Adobe Photoshop dástúrinde kórnislerge qayta

islew beriw, animaciya dastúrleri hám onıń imkaniyatları, Adobe Flash dástúri hám

onıń imkaniyatları, Delphi multimedia imkaniyatları qaraladı. Bul

programmalardan multimedia elektron oqıw resursların jaratıwda paydalanıw

usılları izertlenedi. Ekinshi bap boyınsha juwmaqlaw keltirilgen.

Magistrlik dissertatsiya jumısınıń úshinshi babı Multimedia elektron oqıw

resursların jaratıw metodikası atamasında bolıp, bul jerde tómendegi máseleler

sheshildi:  3D kitap jaratıw, bilimdi bahalaw testlerin jaratıw, multimedia elektron

oqıw resursların jaratıwdı proektlestiriwge anıq mısallar sıpatlap berilgen.Úshinshi

bap sońında juwmaqlaw keltirilgen.

Magistrlik dissertatsiya jumısınıń ulıwma juwmaqlaw bóliminde hár  bir baptan

alınǵan nátiyjeler juwmaqlastırılǵan, soday-aq bul bólimde multimedia elektron

oqıw resursların jaratıw hám onı qollanıw keleshegi haqqında sóz etiledi.

Paydalanılǵan ádebiyatlar dizimi keltirilgen.

Magistrlik dissertatsiya jumısınıń qosımshalar bóliminde glossariy, kеуsler banki,

sabaq islenbe hám multimedia elektron oqıw resursların jaratıw ushın islep shıǵılǵan

programma listingi hám alınǵan nátiyjeler keltirilgen.

Jumıstıń tiykarǵı nátiyjeleri. Ulıwma bilim beretuǵın orta mektep hám olardıń

oqıwshılarınıń pánlerden alǵan bilimlerin bahalaw ushin elektron kúndelik, elektron

tabel, elektron tetrad hám elektron jurnal jaratıw kónlikpelerin qáliplestiriw

boyınsha metodikalıq kórsetpeler tayarlaw, multimedia programmalarınan

paydalanıp multimedia elektron oqıw resursların jaratıw texnologiyasın islep shıǵıw,

informaсion hám internet  texnologiyalar qurallarımenen islesiw, oqıtıw processiniń
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avtomatlastırılǵan usılların jaratıw, mashina programmaların dúziw hám qollanıw

texnologiyası boyınsha metodikalıq pikirler usınıladı.Alınǵan nátiyjeler Nókis

qalasınıń Xalıq bilimlendiriw bólimine qaraslı №4 sanlı ulıwma bilim beriw

mektebiniń oqıwshıları ushın sınap kórildi.

Magistrant Raxmetova Lazzat  2019 jıl 22-sentyabr kuni MS Excel de

formulalar jaratıw   hám MS Excel  diúyreniw boyınsha  online kursında oqıp

certifikat aldı.

Usı magistlik dissertatsiya jumısınıń nátiyjeleri Respublikalıq hám Xalıq aralıq

ilmiy – teoriyalıq konferenciyalarda dodalanǵan hám baspadan shıǵarılǵan[9-14],

Juwmaqlaw hám usınıslardıń qısqasha ulıwmalasqan kórinisi. Multimedia

elektron oqıw resursların jaratıw metodikası qaraladı.
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I-BAP. Multimedia hám onıń texnik-dasturiy quralları

§1.1. Multimedia túsinigi

Informatikanıń tiykarǵı túsiniklerniń biri - bul multimedia túsinigi esaplanadı.

Multimedia bul informatikanıń dástúriy hám texnik qurılmaları tiykarında

audio, video, tekst, grafika hám animaciya effektleri tiykarında oqıw materiyallın

oqıwshılarǵa jetkerip beriw kórinisi bolıp tabıladı.

Multimedia(multimedia-kóp ortaliq) –bul kompyuter texnologiyasınıń túrli

fizik kórinisine iye bolǵan(teks, grafika, súwret, ses, animaciya, video h.t.b) hám hár

túrli tasıwshılarǵa tán bolǵan (magnit hám optik diskler, audio hám video lentalar

h.t.b) informasiyatan paydalanıw menen birge baylanıslı.     Multimedia-kompyuter

informasiyaınıń hár túrli kórinisleri: reńli grafika, tekst hám grafikada dinamik

effektler, dawıslardıń shıǵıwı hám sintezlengen qosıqlar, anımaciya sonday-aq

videoklipler hámde videofilmler menen islew.

Multimedia-bul zamanagoy kompyuterli informasiya texnologiyaları

bolıp, tekst, bideokasetsa, grafika kórinisi hám animaciyanı kompyuter

sistemasına birlestiriw imkaniyatin beredi.

Multimedia ámeliyattaǵı is tártibi- bul appparat dástúriy ortaliq bolıp

kompyuterge informasiyanı kiritiw, islew beriw, saqlaw, uzatıw hámde tekst,

sızılmalar, videokórinis, ses hámde dawıslardı insanǵa zárúr hám qolay turde

jetkeriw.Sonıń menen birgelikte:

Birinshiden, paydalanıwshıǵa álbette interaktiv iskerlik usınıladı, yaǵnıy

insan hám kompyuter ortasındaǵı buyrıqlar hám juwaplar almasıwı táminlep, dialog

ortalıǵın jaratatuǵın dástúriy jemis. Ekinshiden, túrli video hám audio effektlerdi

isletetuǵın ortalıq. Ol  tamashagóyge ózinshe ol yaki bul qosımshanı tallaw

imkaniyatın beriwshi videofilmdi esletedi.

Multimedia texnologiyası informasiyanı hár bir waqıttıń ózinde insanǵa

túsinerli kóp kórinislerdiń  kombinanciyasın usınadı. Bul texnologiya informasiyanı

izlew,nusqalaw hám basqa kompyuterge kórsetilgen kórinisti kóshirip ótkize alıw



9

hám olardıń qálegen bir kombinaciyasını jaratıw imkaniyatına iye.     Bulardan

tısqarı multimedia texnologiyasınan paydalanıwshı ózi dizayn menen shuǵıllana

alıwına imkan beredi, sonday-aq statik(háreketsiz) hám dinamik(háreketleniwshi)

kórinislerdi jaratıw hámde óz dóretiwshilik isinıń nátiyjeleri arqalı, yamasa kanallar

arqalı sırtqı átirapqa tarqatıw mumkin.

Multimedia sistemasınıń tezlik  penen rawajlanıwına shaxsıy

kompyuterlerdiń imkaniyatları keńeygenligi hám texnik dástúriy qurılmalardı

rawajlandırıw sebeb boldı. Sonǵı jıllarda kompyuterdıń tezligi hám yad qurılması

keskin ósti, sonday-aq, grafika imkaniyatları keńeyip sırtqı yad qurılmasınıń texnik

kórsetkishleri jaratıldı. Multimedia texnologiyalarınıń rawajlanıwı videotexnika

jónelisi, lazer diskler, sonday-aq, jazıw texnikasınıń hámde dawıs hám kórinisti

payda etiwshi texnologiyalarınıń rawajlanıwına úlken úles qostı. Informasiyanıń

yadta optimal jaylasıwı hámde saqlaw maqsetinde tez hám nátiyjeli usıllardıń

jaratılıwı áhmiyetli bolıp esaplanadı.

Multimedia qurılmaları-bul apparat hám dástúrler toplamı bolıp ol insanǵa

ózi ushın  tábiyiy bolǵan túrli-aymaq átirapların: dawıs, video, grafika, tekst,

animaciya hám basqalardı isletken jaǵdayda kompyuter menen sáwbet qılıw

imkanńyatin beredi.      Multimedia dástúriy quralları tómendegilerden ibarat: Video

jaziw hám redaktorlaw quralları, Manipulyatorlar, Maǵlıwmat tasıwshılar, Virtual

barliq quralları, Dawis jaziw hám dawistı redaktorlaw quralları. Hár birine sıpatlama

beremiz.

Súwretlerdi kóriw hám olar menen islew ushın móljerlengen dástúriy

qurılmalardı Adobe Photoshop, Corel Photo-Paint, Paint Shop Pro, Microsoft

Picture It, Visualizer Photo Studio, Pixel image editor, PixBuilder Photo Editor,

Fo2Pix ArtMaster lerge kiritilerdi.

Dawıs jazıw qurılmaları. Dawıslı  fayillardı kompakt diskke jazıw, multimedia

prezentaciyaların tayarlawda, videokonferenciyalardı   ótkeriwde , oyınlardı

oynawda, audio  CD  lardı esitiw  ushın dawıs platası  yaki audio adapter(audio-bul

“dawıs”, adapter bolsa –maǵlıwmattı kompyuterge ótkeriwshi texnik qurilma) dep

atalıwshı karta zarúr boladı. Bul dawıstı qayta islewshi dawıs platası, dawıs
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shıǵarıwshı qurılma, akustik sistemalar yaki jeke tińlawshılar hámde audio

maǵlıwmatlardı kirirtiw ushın xizmet qılatuǵın  mikrafon, dawıslı kompakt-disk

proigravatelleri, dawıs kolonkaları hám basqa qurılmalarǵa jalǵanadı. Dawıs platsı

sonday-aq magnitafon, elektr muzika asbapları esaplanadı.

Video jazıw hám video redaktorlaw qurılamaları. Video menen tolıq islew

ushın video maǵlıwmatlardı kompyuterge say kórinis hám  haqıqıy qaytarıwshı

videokarta zarúr. Onda videokamera, videomagnitafon hám televizor sıyaqlı

qurılmalar jalǵanıwı kerek. Keri jaǵdaylarda video elementlerdi monitorda jetkerip

beriwi jeterli boladı. Usınday máseleni sheshiwde hár qanday zamanagoy

kompyuterge tán bolǵan video adapter hám monitor jeterli boladı.

Maǵlıwmat tasıwshılar. CD-R(Compact  Dick –Recordable- jazılıwshan disk),

CD-RW( Compact DiskRewritable-1000 márte qayta jazıw mumkin bolǵan disk)-

lazerli(kompakt) diskke 650 Mbayt(700 mbayt) sıyımlıqtaǵı maǵlıwmatlar jazıw

múmkin.

DVD(Digital Versatile Disk) diskler bir yaki eki tárepleme maǵlıwmat  jazıw

imkaniyatın beriw tárizinde tayarlanadı. Táerpler sanına qarap DVDler DVD-5,

DVD-9, DVD-10, DVD-14, DND-18 túrlerine bólinedi hám usıǵan tán  5, 9, 10, 14,

18 Gb maǵlıwmatın saqlaydı

HD DVD(joqarı anıqlıqtaǵı nomerli universal disk)- DVD disklerine

qaraǵanda joqarı anıqlıqtaǵı hám kólemge iye. HD DVD diskleri DVD disklerine

qaraǵanda 5 márety kóbirek xabar saqlaydı. HD DVD disıkleri xabarlar bir qatlamlı

diskke 15Gb, eki qatlamlı diskke 30 Gb tń qamtıydı.

Blu-ray Disc, BD( ing. Blue ray-hawa nur hám disc-disk) optik tasıwshı

formatı bolıp, nomerli xabardı joqarı anıqlıqtaǵı videomateriallardı úlken kólemde

jazıw imkanin beredi. Blu-ray Disc xabarlardı oqıwda qısqa tolqınlı lazer (405) ten

paydalanadı. Bul diskler xabar kólemi bir qatlamlı diskte 25 Gb, eki qatlamlı diskte

50 Gb ti quraydı.

Manipulyatorlar. Kompyuterdi basqarıw ushın  apıwayi, qolay hám

ǵalabalıq bolǵan qurılmalardan biri bul manipulyator( tishqansha) esaplanadı.
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“Virtual barlıq” qurılmaları. Virtual barlıqqa kiritiwdiń ápiwayı jolı

kompuyter ekranı esaplanadı hám bul barlıqta tıshqansha, klavitura, djoystik

járdeminde islew múmkin.

Bulardan tısqarı virtual barlıqtı jaqsıraq seziniw ushın basqa qurılmalardı da

isletiw kerek. Olar:

Túrli aynalı kózáynek- bul qurılma kórinisti úsh ólshemde  kóriniwge

járdem beredi.

Bir qansha qıyın isleytuǵın kózáynek bar bolıp, onıń isletiw  principi

tómendegishe: ekran arqalı kózáynektiń  bir kózine kómrinis jiberiledi, ekinshisi

qaranǵı bolıp turadı. Soń kórinis keyingi kózge ótedi usı sıyaqlı  kórinis izbe-iz

kórsetiledi hám kózáynek ekranda úsh ólshemli illyuziyası payda boladı.

Virtual barlıq shlemi- (Head Mounted Display)-oylap tapılǵan virtual barlıq,

barlıqti  tolıq seziniw ushın móljellengen qurılma. Kórinis kólemin kórsetiw ushın

úlken bolmaǵan ekran jaylasqan bolıp, kórinis hám ekige bólinedi hám eki kóz ushın

óz aldına kórinis jaratıladı.  Bul shlem 360 gradus barlıq kórinislerdi vizual kóriw

imkanın beredi, sonı menen birge bas burılǵan waqıtta más túrde jaylasıwıda

ózgeredi.

Xabarlı qolǵap-virtuallıq ósiriw maqsetinde isletiwshi qolǵap bolıp, onıń

járdeminde virtual barlıqtaǵı  predmetlerdi uslaw, súriw hám háreketke keltiriw

múmkin.

VR-kostyumi-virtual barlıqtıń eń tolıq toplamlı qurılması esaplanadı.

Denenıń tolıq toplamlı qurılması esaplanadı. Denenıń barshe noqatlarındaǵı

háreketin gúzetip barıwshı kóp magnitli sensorlardan ibarat kombizon.

Multimedia sistemasınıń dástúriy  toplamın hám  ekige bóliw múmkin:

ámeliy  hám joybarlastırılǵan. Ámeliy dástúrleri paydalanılıp atırǵan yaki

joybarlastırılǵan ámeliy dástúrler esaplanadı.

Joybarlastırılǵan dástúrlerge multimedia ilovaların jaratıwshı dástúriy

qurılmalar kiredi. Bul topardaǵı dástúrler grafik redaktor, videkórinis  redaktorı,

dawıslı xabardı payda qılıwshı hám redaktorlaw qurılmaları kiredi.

Demek, zamanagóy multimedia texnologiyaların tálim processinde qollanılıwı:
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-úyrenilip atırǵan jaǵday hám processlerdi modellestiriw arqalı pán jónelisinde

shuqır ózlestiriw;

- oqıw iskerliginiń hár qıylı shólkemlestiriwi esapqa alınıwı tıńlawshılardıń

erkin islerligi jónelisiniń keńeyiwine  úles qosadı;

- interaktiv, sáwbet imkaniyatların paydalanıw tiykarında oqıtıw processin

individuallastırıw hám differenciyalastırıwǵa járdem beredi;

- jasalma intellekt sisteması imkaniyatlarınan paydalanıw arqalı

tıńlawshılardıń oqıw materiyalın ózlestiriw strategiyasın iyelew;

- informaciyalıq  jámiyet aǵzası sıpatında ondaǵı informaciya mádeniyatın

jaratıw

-úyrenilip atırǵan processin hám hádiyselerdi kompuyter texnologiyaları

qurılmalar usınılıwı oqıwshılarda pán tiykarlarında qızızqtırılıwı hám  iskerlikti

asırıwǵa alıp keliwi menen áhmiyetli bolıp esaplanadı

§1.2. Multimedia elektron oqıw resursları

Dúnya júzine nazer salatın bolsaq kompyuter grafikası hám dizayn júda keń

dárejede rawajlanǵan.  Olar ámelde kópten berli qollanılıp kelmekte. Biraq bul

jaratılǵan barlıq dástúrler , roliklar, dizaynlerdiń tiykarǵi bólegi  kinofilmler,

multifilmler, web-saytlar ushın jaratılmaqta. Arnawlı pánlerde  multimedialı

sabaqlardıń kemligi,  barlardıńda anıq bir  pán temaların tolıq ajıratıp bere almaslıǵı,

tálim sistemasının bul tarawına úlken itibar qaratıw lazım ekenligin kórsetedi. Biraq

elektron  sabaqlıqlarga kiritilgen tekstli jazıwlar, súwretler  grafikanıń eń zamanagóy

jónelisi bolǵan  roliklerdiń jaratılıwı, oqıwshılardıń multimedia oqiw resurslarina

bolǵan qızıǵıwshılıǵın arttıradı. Sabaqlardıń multimedia imkaniyatlarınan

paydalanıp ótiliwi oqıtıwshılarǵa bir qansha imkanıyatlar jaratadı. Sebebi bul pánge

yamasa temaǵa dawıslı dástúrler, súwretli islenbeler, háreketli jazıwlar,

multipikaciya kórinisinde jaratılǵan filmler, animaciyalar bir tárepten oqıtıwshı

ushın bolsa ekinshi tárepten tálim alıwshılar ushın qızıqlı hám dıqqattı ózine tartıwı,

temanı jaqsı ózlestiriwine jardem beredi.
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Multimedia texnologiyalarınıń áhmiyeti hám belgilerin sanap ótemiz:

-hár túrli kórinistegi úlken kólemdegi xabarlardı bir diskte saqlaw imkaniyatı

bar( bir neshe baplı materiyallardı, mıńlap joqarı sıpatlı kórinislerdi bir neshe saatlıq

filmlerdi hám roliklerdi hámde sesli xabarlardı);

-sıpatı saqlanǵan halda ekran kórinislerin bóleklerge ajıratıw yaki eń qızıq

hámde kerekli bóleklerdi úlkeytiw imkani bar;

-grafika, kórinis hám súwretlerdi salıstırıp analiz qılıw, olardıń kórsetkishlerin

esaplaw, ilimiy yaki úyreniw maqsetinde dástúriy qurlımalar járdeminde islew beriw

imkaniyatı;

- kórinis yaki kórinisti jaratıw maqsetinde paydalanǵan tekst hámde  basqa

kórsetilgen xabardan  gilt sózlerin yaki kórinistiń kerekli bóleklerin maǵlıwmat alıw

hámde túsindiriw ushın kerekli xabarlardı ajıratıp alıw imkanı bar;

-statik yaki  dinamik kóriniske úziliksiz muzika hámde basqa audio redaktorın

alıp barıw imkanıyatı;

-global Internet tarmaǵına jalǵanıw hámde onıń resurslarınan paydalanıw

imkaniyatı bar;

-grafika hám dawıs redaktorları, grafik xabar hám tekstlerge islew bere

alatuǵın ámeliy dástúrler menen islew.

Joqarıda sanap ótilgen  áhimiyetleri hám belgilerden tisqarı jane kóp

imkaniyatlarda bar, kórinisti yaxlit yaki avtomatik tárizde  tańlanǵan jerde saqlap

yaki belgilep qoyıw;

Multimedia sistemalarınıń payda bolıwı  xabar texnologiyasınıń

rawajlanıwına hám ilim-pánde, tálimde, sawda da (bizneste) medicinada keń

kólemde paydalanıwǵa alıp keldi.

Xabar texnologiyalarınıń multimedia qurılmaları oqıw dawamında

tómendegi eń kerekli  tárepleri   menen    áhimiyetli:

-differencial hám individual oqıtıw processin shólkemlestiriw

- oqıw processin bahalaw, teskeri baylanıs ornatıw

-ózin-ózi tekseriw hám dúzetip barıw

- úyrenilip atırǵan pánlerdi kórsetiw hám olardı dinamik  processin kórsetiw
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- pán temalarında animaciya, grafika, multipilkaciya,  dawıs sıyaqlı

kompyuter hám xabar texnolagiyalarınan paydalanıw

-oqıtıwshı talabalarǵa pándi ózlestiriw ushın strategik kónikpelerdi ornatıwı.

Sonday-aq multimedia qurılmaları  ámeliy tárepi oqıw processinde

paydalanıw hámde keliside  tálim sistemasında oqıw processi ushın  maǵlıwmatlar

bazasın hám animacion prezentaciyalar jaratıwday zarúrli wazıypalardı ámelge

asırıwǵa zaman tayarlaydı.

Multimedia joqarı rawajlanıp atırǵan zamanagoy xabar texnologiyası. Onıń

ajıralıp turıwshı belgilerine tómendegiler kiredi:

-xabardıń hár túrliligi: uliwmaliq( tekst, kesteler, besezkler hám basqalar)

orginal( muzika, videofilmlerden  kórinisler, telekadrlar, animaciya htb) túrlerin bir

dástúrde intergraciyalaydı

-belgili waqıttaǵı jumıs , óz tábiyatına baylanıslı statik bolǵan tekst hám

grafikadan ózgeshe túrde , audio hám videosignal tek  waqıttıń málim aralıǵında

kórip shıǵıladı. Video hám audio  xabarların kompyuterde qayta islew hám qayta

kórinis ushın  oraylıq processor tez háreketsheńligi, maǵlıwmatlar jollaw shinasın

ótkeriw qábiletin operetiv hám video yad , úlken ólshemli sırtqı yad, kólemli  hám

kompyuter kiriw-shıǵıw kanalları boyınsha almasıw tezligin eki ese artqanlıǵın talap

etedi

-“insan-kompyuter” interaktiv baylanıstıń jańa dárejesi, bunda baylanıs

processinde paydalanıwshı keń hám hár tárepleme xabarlardı aladı, bul jaǵday islew

yaki dem alıw sharayatların jaqsılanıwına imkan jaratadı

Sıpatlı multimedialı elektron oqiw resurslarını islep shıǵıwǵa túrli bir birinen

ózgeshe texnologik usıllar bar.Bular tómendegishe bólinedi:

Prezentaciya (ing. Presentation)-audiovizual qurılmalardan  paydalanıp

kórgizbeli túrde  maǵlıwmatlardıń usınılıwı. Prezintaciya jeke ulıwmalasqan

kompyuter animaciyası, grafika, video, muzika hám dawıstı óz ishine qamtıydı.

Ádette prezintaciya maǵlıwmattı qolay qabıl qılıwı ushın  syujet, scenariy hám

strukturaǵa iye boladı.
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Animacion rolikler. Animaciya – multimedialı texnologiya,  kórinisti

háreketlenip atırǵanlıǵın kórsetiw ushın kórinislerdiń izbe-izligin kórsetiw. Kórinis

háreketin sawlelendiriw  effekt sekundina 16 kadrdan artıq videokadrlardıń

almasıwınan payda boladı.

Oyınlar. Oyın dem alıw, kewil kóteriw múmkinshiliklerin qandırıw,

organizmdegi shart-sharayattı joyıtıw hámde málim bir kónikpelerdi rawajlanıwına

jónelitirilgen multimedia resursı.

Bideoqosimshalar- háreketleniwshi kórinisler islep shıǵıwshı texnologiyası

hám kórinisi. Bideo kórinisler oqıw qurılmaları-videofilmlerdi basqarıw dástúrleri.

Multimedia-galeryalar. Galeryalar-dawıs tolqınlıǵı háreketlenıwshi

súwretler toplamı.

Audioqosimshalar. Dawıslı fayıllardı  oqıwshı qurılmalar-nomerli dawıslar

menen islewshi dástúrler. Nomerli dawıs-bul elektron signal amplitudasınıń diskret

sanları menen esaplanadı.

Web ushın qosimshalar-bul óz aldına veb-betler, onıń quramı bóleklerge

maǵlıwmat jiberiw ushın qosimshalar, kóp kanallı qosimshalar, chatlar hám

basqalar.

Virtual barlıq túsinigi.  Informatika hám xabar texnologiyaları jónelisinde

virtual túsinigi keń túrde qollanılǵan. Máselen: virtual mashına, virtual yad, virtual

disk, virtuak baylanıs, virtual sayaxat, virtual klass htb. Bir ǵana usı baǵıtta da virtual

túsinigi  forma hám mazmunlarında qollanılıp kelmekte hám  bir-birinen parıqlı

mánilerdi ańlatadı. Máselen multimedia sisteması virtual barlıq mánisin beredi.

Virtual (lat Virtualis- múmkin bolǵan yaǵnıy  belgili bir sharayatta  júz

bergen  yaki beriwi múmkin bolǵan) túsinik  nárseler hám hádiyselerdıń waqıt hám

aymaqta payda bolmaǵan biraq obektiv nárseler yaki subektiv obrozlardı ámelge

asırıwda  itimalı bar bolǵan processti ańlatadı.

“Virtual barlıq” ataması 1970-jılları aqırında Massachuset texnologiyası

institutında  Jaron Lanier tárepinen oylap tabılǵan. Ol 1984-jılda dúnyada  birinshi

virtual barlıq firmasın shólkemlestirdi. Bul atama  kompyuterda jaratılǵan átirapta

insannıń barlıǵı ideyası sawlelendiredi. “Virtual barlıq” ataması amerikalıq
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kinomagnitafonshılar tórepinen kiritilgen. Olar belgili sebeplerge kóre tabiyiy jol

menen ámelde islep bolmaytuǵın  oylaw imkanyatlarınıń belgili-grafik formada

jasalma ámelge asırıw  múmkinligi haqqında kinolentanı usı at penen shıǵarǵan.

Virtual barlıq insan real barlıqta hareket qılıp atırǵan illyuzasın kompyuterda jaratıw

imkanın beriwshi interaktiv texnologiya.  Bunda obektiv barlıqtı tabiyiy seziw

organları járdeminde payda etiw  ornın tiyisli interfeys, kopyuter  hám dawıs

qurılmasında jasalma jaratılǵan kompyuter xabarı iyeleydi. Virtual barlıq ámelde joq

nárseni, onı qol menen uslaw, onıń dámi hám iyisin seziw múmkin emes. Usıǵan

qaramastan ol bar hám  insan bul álemge kirip onı gúzetip qoymastan basınan

keshiredi, bálkim tásir kórsetiw imkaniyatına da iye boladı bul álemde erkin háreket

qıladı hám onı ózgerte aladı. Virtual álem-insan barlıǵınıń ózine tán forma hám

adamlardıń manawiy baylanısların ózine tán mádeniy kórinisi. Biraq virtual barlıq

real fizik barlıqtay lazzet bere almaydı, sebebi  bul barlıq tásirinde payda bolatıǵın

sezimler kobnese onıń ózi menen emes, bálki onı biz qanday oylawdi etiwimiz benen

belgilenedi. Biz vertual teńizde shomılıwımiz múmkin biraq payda bolatuǵın tuyǵı

bul teńizdiń qanday oylawımızǵa baylanıslı. Virtual barlıqtı insan jaratadı. Sol

sebepli virtual barlıq  bar barlıq nárseler insan oyı esaplanadı.  Virtual barlıq obektiv

tárizinde  yaǵniy insan miyinde emes balki kompyuterda payda boladı. Házirgi

waqıtta ol insan oyında. Insan tárepinen jaratılǵannan keyin ol insan oyında jasawdı

dawam etedi, bul oyda har túrli tásir kórsetedi.

Búgingi kúnde virtual barlıq insan manawiy iskerliginıń túrli jónelislerinde

qollanılmaqta. Virtual barlıq eń aldı menen  ol payda bolǵan jóneliste tiykarınan

fizikada suyıqlıq hám gazler dinamikasın modellestiriwde, ximiya  ximiyalıq

reakciya modelin dúziw, geologiyada hám geografiya pánlerinde paydalanbaqta.

Injinerlik jónelisinde ásirese  qáwipli sharayatlarda: ashıq kosmosta, deńiz

hám okeanlarda, yadro injinerliginde aralıqtan basqarıwda virtual barlıq keń

paydalanıladı. Kompyuter dizayni hám onıń ajıralmas bólegi, sebebi kompyuter

islep shıǵarıw, raketalar hám samalyotlar , avtomobiller úlken konstrukciyanı

sınawdan  ótkeriwde  kórinisler birlestiredi.  Virtual barlıq texnologiyasınan áskerler

de keń paydalanbaqta. Máselen AQSH armiyasında askeriy xuzmetshilerde
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mergenlik kónikpelerin rawajlandırıwda imtitatorlardan gúres sharayatında tez hám

durıs qarar qabıl  qılıw kónikpesin rawajlandırıw ushın  áskeriy doskalardan

paydalanıladı. Tank bóleklerinda tankten oq atıwdı hámde gúreste askerler menen

oficerlerdin  jeke qatnasıwdı imitaciya qılıwshı áskeriy oyınlardan paydalanılmaqta.

Joybarlastırılǵan biraq ele jasalma qural-asbap haqqında sınawdan

ótkerilmekte.  Áskerler alınǵan maǵlıwmatlardı anliz qılıw hám olarǵa baha beriw

ushın kompyuter imitaciyadan paydalanbaqta.  Tálim jónelisinde shınıǵıw

trenejyorlardı jaratıwda virtual barlıq texnologiyasınan paydalanbaqta. Jaqında

virtual kitapxana hám muzeyler shólkemlestiriw koncepciyası usınıldı. Máselen

virtual kitapxanalarda paydalanıwshı kompyuter járdeminde kitap shkaflarinıń

vizual tasiri menen háreketleniwi, kerekli ádebiyatlardı tabıw hám kózden ótkeriw,

zarúr jaǵdaylarda olardan kóshirme alıw. Virtual muzey koncepciyas

paydalanıwshılarǵa kollekciyadan qálegen eksponattı onıń tabiyiy úsh ólshemdegi

kóriniste kóriw imkanin beredi. Biraq bul  kórinis joqarı displeylardı kórsetedi.

Virtual barlıq  bul jasalma payda bolatuǵın  xabar bolıp ol átirapti adettegidey

usılda oylawdı túrli texnik qurılmalar tiykarında payda qılatuǵın  xabasrlar menen

almastırıwǵa qaratılǵan. Tálim maqsetlerinde virtual reallıq qurılmaları  islep

shıǵarıwǵa qaratılǵan xabarlardı  vizuallastırıw qurılmaları  jaratıw basqa  texnik

qurılmalar járdeminde  erisip bolmaytuǵın pedagogik nátijeni beriw múmkin.

Virtual barlıq immersivlik hám interaktivlik túsinikleri menen baylanıslı.

Immeresivlik degende adamdi virtual barlıqta ózin oylawdı tásiniw lazım.

Interaktivlik paydalanıwshı real waqıtta vertual barlıqtan obektler menen óz-ara

baylanısta bolıp tásir kórsetiwine iye boladı.

Virtual barlıq túrleri:

- passiv virtual barlıq (passsive virtual reality)-insan tárepinen

basqarılmaytuǵın avtonom grafik tásirin dawıs penen gúzetiliwi

- tekseriliwshi virtual barlıq shegaralanǵan tárizde paydalanıwshıǵa usınıs

qılınatuǵın scenariy, súwret, dawısti tańlaw imkaniyatınıń barlıǵı;
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- interaktiv virtual barlıq treking waziypasin orinlay alatuǵin arnawlı qurilma

járdeminde jaratılǵan dúnya nızamları tiykarında virtual barlıqti paydalanıwshı ózi

basqara alıwı.

Treking virtual ortalıqtaǵı real obyekttiń jaylasıw kordinataların (x,y,z) hám onı

keńislikte jaylasıwı múyeshlerin (a,b,g) beriwge móljerlengen.

Virtual barlıq túsinigi degende- biz imitacion dástúriy hám texnik qurallardı

qabıl qılamız.Interaktivlikti támiynlew ushın, virtual sistema basqarıwshı ámellerdi

qabıl qılıwı kerek. Bul ámeller kóz benen kóretuǵın, dawıs arqalı qabıl qılanatuǵın

bolıwı kerek. Bul ámellerdi ámeliyatta orınlaw ushın zamanagóy sistemalarda túrli

dawıs hám videotexnologiyalardan paydalanıladı. Máselen, úlken kólemli dawıs

hám videosistemaları sonday-aq adamnıń bas bólegine ornatılatuǵın shlem hám

kózáynek displeyler, iyis sezetuǵin, tishqanshalar,basqariwshı qalpaqlar,kibernetik

kiyimler, simsiz interfeys birgelikte isletiledi.

Virtual barlıqtıń insániyat ushın tásiri:

-Insan ómirin payda etiwde hám tártipke saliwda;

-insan ortasındaǵı baylanıstıń jańasha kórinisi;

-Dúnyanıń tiykarǵı tarawları siyasat, ekanomika, sanaat hám turizm tarawlarina

unamli tásir barlıǵı;

- Virtual álem menen insan ózinıń tártip qaǵiydalari hám óz ortaliǵin

jaratiw múmkinligi;

- turmıs hám virtual barlıq ortasındaǵı aldanıw barlıǵı.

Virtual barlıqtıń rawajlanıwındaǵı úsh ólshemli ortalıq hám internet

texnologiyalarınıń imkaniyatlarınıń rawajlanǵanlıǵı úlken tásir ótkizedi.

Nátiyjede,túrli tarawlarda virtual reallıq isletile baslandı.

Virtual barlıqti házirde internet texnologiyalarısız kóz aldımızǵa keltiriw qıyın.

Internet – XX ásir sıyqırı. Kim artta qalıp ketse, keyin virtual dúnya rawajlanıwına

jete almaydı. Internet – insánıyat qabıl qılıwınıń jańa ólshemi. Onı iyelew bir

tárepten ańsat, ekinshı tárepten quramalı. Onıń ańsatlıǵı sonnan ibarat, dástúrlerdiń

eń ańsatı ápiwayı browserlerden paydalanıwdı bilseńiz jetkilikli.
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Internettiń barlıq xizmetlerinen paydalanıw ushın bul dástúr jetkilikli.

Bunıń ushın birinshı internet xizmetlerinen paydalanıw boyınsha bilim hám

máleke talap qılınadı, ekinshıden, tarmaqtaǵı qızmet hám maǵlıwmatlar tiykarınan

shet-tillerinde berilgen. Ózbek tilinde usınıs qılınǵan xizmetler, baspadan

shıǵarilǵan maǵliwmatlar házirshe kóp emes.

Ámeldegi turmısdaǵı bar zatlar Internette – ulıwma  ǵalabalıq kompyuter

tarmaǵında da sáwlelengen. Onı tolıq iyeleseńiz: xat jazıp, juwabın

sekundalarda alasız, tanısıp, ortalıqta sáwbetler qurasiz, seminar, konferenciyalar

qatnasasız, sırtqı oqıw jurtlarda tálim alasız, til

úyrenip, shet el tekstlerin awdarmalaysız, sózliklerden paydalanasız,

ájayıp ulıwma ǵalabalıq entsiklopediyalarınan paydalanasız, kitap, gazeta hám

basqalardı oqıysız,  úyińizde dúnya kitapxanası boladı,  uyińizde  ótırıp

biznes hám dóretiwshılik penen shuǵıllanasız, pullı hám

pulsiz ámeller orınlaysız, dúnyaǵa sayaxat qılasız, virtual (qıyalıy) turmısqa kiresiz

hám taǵı basqa.

Qullası, Internette de turmısdaǵı sıyaqlı barlıq waqıya hám hádiyselerde real

hám virtual qatnasıwıńız múmkin.

Vitual bolmıs dep real dúnyanı kompyuter simulyatsiyası arqalı jaratılǵan

ortalıǵına aytıladı. Vitual bolmısnıń tiykarǵı 3 ayırmashılıǵı bar. Olar:

- tásir sheńberinıń keńligi;

- joqarı vizuallasǵanlıǵı;

- úsh ólshewli ortalıq.

§1.3. Interaktiv tálim usılları

Multimedialı elektron oqıw resursların jaratıw barısında interaktiv talim usılların

paydalanıw bilim beriwdin en optimal jolı esaplanadı. Menin pikirimshe

multimedialı elektron oqıw processinde tomendegi interaktiv talim usılların

informatika oqıtıwshıları islete biliwi maqsetke say boladı. Bunday usıllar qázirgi

waqıtta juda kop.
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Metod    sózi    grekshe    izertlew,    maqsetke    erisiw    jolı,    usılı    degen

bolıp    tabıladı.    “Metod    eń    ulıwma    mániste        maqsetke erisiw    usılı,

belgili tárizde    tártipke    salınǵan    iskerlik”.   Tálim    metodı - oqıtıwshınıń

talaba-studentler    menen    hámme    waqıt        qollaytuǵın    olarǵa    óz    intellektual

qábiletlerin    hám    qızıǵıwshılıqların    rawajlandırıwdıń,    bilim    hám

kónlikpelerdi    iyelew    hámde    olardan    ámelde    paydalanıw    imkaniyatın

beretuǵın    jumıs    usılı.

Usıl - geypara  zat,  hádiyse,  processni  úyreniw  yamasa  ámelge  asırıw

tártibi.

Ínteraktiv”    termini    negizi    inglizshe    “ınteraktiv”    sózinen    alınǵan

bolıp,    “óz-ara    birge    islesiw”    mánisin    ańlatadı    hám    qandayda    bir

iskerlik    yamasa    metodta    óz-ara    tartıs,    pikirlew    tiykarında    iskerlik

yamasa    birgelikte hal    etiw    túsiniledi.

Ínteraktiv    (“inter”-vzaimniy,    “akt”-deystvie-“            ózara    tásir”    mánisin

ańlatadı)    uslubiy    jandasıwda    talabalar    biliw    hám    úyreniw    procesine

pútkilley    kirisip    ketedi,    olar ózleri    bilgen    hám    oylap    atırǵanları

haqqında    tartısıwları    da    múmkin.    Tartısıw    dawamında    talabalar    pikirlerin

óz    qatarlaslarına    qanday    túsindiriw    kerekligin,    óz    pikirlerin    qanday

bayan    etiwdı    úyrenedi.    Ínteraktiv    usıllar    sabaqlarda    maqsetke    erisiw

ushın    jetkilikli    zamin    jaratadı.

Oqıtıwshı    sabaq    rejesin    dúzedi.(qaǵıyda    boyınsha    ınteraktiv    shınıǵıw

hám    tapsırma    lar    talaba    ózlestirip    atırǵan    material    menen    óz-ara

baylanıslı    boladı).    Talabalar    orınlaytuǵın    interaktiv    sabaqtaǵı    ınteraktiv

shınıǵıw    hám    tapsırmalar    onıń    tiykarǵı    quramı    bolıp    esaplanadı.

Zamanagóy    tálimdi    shólkemlestiriwge    qoyılatuǵın    zárúrli    talaplardan

biri    artıqsha    psixikalıq        hám    fizikalıq    kúsh    sarp    etiw    etmay,    qısqa

waqıt    ishinde    joqarı    nátiyjelerge    erisiw    bolıp    tabıladı.    Qısqa    waqıt

arasında    arnawlı    bir    teoriyalıq    bilimlerdi    talabalarǵa    jetkiziw,    olarda

belgili    iskerlik    maydanıdan    kónlikpe    hám    ilmiy    tájriybelerdi    payda

etiw,    sonıń    menen    birge,    talabalar    iskerligin    baqlaw,    olar    tárepinen
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iyelegen    bilim,    kónlikpe    hámde    ilmiy    tájriybeler    dárejesin    bahalaw

oqıtıwshıdan    joqarı    pedagogikalıq    uqıp    hámde    tálim            procesine

salıstırǵanda    jańasha    jantasıwdı    talap    etedi.    Ínteraktiv    usıllardıń    bir

qansha    túrleri    bar    bolıp,    hár    biriniń    ózine    mas        wazıypası    bar.

Usılar    toparına “Aqılıy hújim”, “FCMU” , “KEYS-STADI”,

“Basekelesiw”  metodları, “Túsinikler    analizi” ,    “3x4”    ,    “Labirint” ,

“Skarabey” ,    “Jelpiwish”,    “Baylanıs” ,    jazba    tartıs    (debat)    lar   ,

“Munasábet”    usılları  sıyaqlılar    kiredi.

Bul usıllardı kórip shıgamız.

“ Aqılıy hújim” metodınıń basqıshları tómendegilerden ibarat:

1. Tálim alıwshılarǵa soraw beriledi hám usı soraw boyınsha óz juwapların(

pikir, ideya hám usınıslar) bildiredi.

2. Tálim alıwshılar soraw boyınsha óz pikir-usınısların bildiredi.

3. Tálim alıwshılardıń pikir-ideyaları(magnitafon, videokasetaǵa, reńli

qaǵazlarǵa yaki doskalarǵa) toplanadı.

4. Pikir-ideyalar málim belgiler boyınsha toparlanadı.

5. Joqarıda qoyılǵan sorawlarǵa anıq hám durıs juwap tańlap alınadı.

“Aqılıy hújim” metodınıń  ahmiyeti:

. nátiyjelerdiń bahalanbawı tálim alıwshılarda túrli pikir-ideyalardıń

rawajlanıwına alıp keledi.

. tálim alıwshılardıń barlıǵı qatnasadı.

.pikir-ideyalar vizuallastırılıp barıladı

.tálim alıwshılardıń baslanǵısh bilimleri tekserip kóriw imkaniyatı

. tálim alıwshılardıń temaǵa qiziǵiwshılıǵın oyatıw

“ Aqılıy hújim” metodınıń kemshilikleri:

. tálim beriwshi tárepinen sorawdı durıs qoymawı

.tálim beriwshiden joqarı dárejede esitiw qábileti talap etiledi.

“FCMU” metodı texnologiyasi.

Texnologiyanıń maqseti: Texnologiya qatnasıwshıdaǵı ulıwmalıq

pikirlerden tiyisli juwmaqlardı shıǵarıw, salıstırıw arqalı xabardı ózlestiriw sonday-
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aq erkin dóretiwshilik pikirlewdi rawajlandırıwǵa xizmet qıladı. Texnologiyadam

lekciya sabaqlarında bekkemlewde ótilgen temanı sorawda, úy tapsırmasın beriwde

hámde ámeliy sabaqlar nátiyjelerin analizlewde  paydalanıwǵa boladı.

Texnologiyanı ámelge asırıw tártibi:

-qatnasıwshılarǵa temaǵa baylanıslı bolǵan juwmaq yaki ideya  usınadı

- hár bir qatnasıwshıǵa PSMU texnologiyasınıń basqıshları jazılǵan

qaǵazlardı tarqatadı

P Pikirin’izdi bayan etin’

S Pikirin’izdin’bayanina sebep ko’rsetin’

M Ko’rsetken pikirlerin’izdi dalellewge misal ko’rsetin’

U Pikirin’izdi uliwmalastirin’

PSMU analizi qatnasiwshılarına kasibiy-nazariy bilimlerdi ámeliy sabaqlar hám

tájriybeler tiykarında tez hám nátiyjeli ózlestiriwge tiykar boladı.

“KEYS-STADI” metodı

“KEYS-STADI”- ang.(case- anıq háreket, hádiyse, “stadi”-úyreniw,

analizlew) aniq háreketlerdi úyreniw, analiz qılıw tiykarında oqıtıw ámelge asırıwǵa

qaratılǵan metod esaplanadı.  Bul metod dáslep 1921-jılı Garvard universitetinde

ámeliy háreketlerden  ekonomikalıq basqarıw pánlerinıń úyreniwde paydalanıw

tártibinde qollanılǵan. Keysde ashıq xabarlardan yaki waqiya-hádiyselerden jaǵday

sıpatında analiz ushın paydalanıw múmkin. Keys háreketleri oz ishine

tómendegilerdi qamtiydı: Kim(who), qay jerde(where), ne ushın(why), qanday-

qalay(how), qanday nátiyje(what).

Keys metodin a’melge asiriw basqishlari

Jumis basqishlari Alip bariw ko’rinisi ha’m mazmuni

1-basqish: Keys ha’m onin’ axborat

ta’minati menen tanistiriw

-Jeke ta’rtiptegi audio-vizual jumis

-Keys penen tanisiw(tekstli,audio ya’ki

media ko’riniste)

-informaciyani uliwmalastiriw
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-informaciyani analizlew

-Mashqalalardi aniqlaw

2-basqish: Keysti aniqlastiriw ha’m

oqiw tapsirmasin belgilew

-Individual ha’m toparlarda islew

-mashqalalardin’ a’himiyetlilik ierarxiyasin

aniqlaw

-Tiykarǵi mashqalali situaciyani belgilew

3-basqish: Keystegi tiykarǵi

mashqalani analiz qiliw arqali oqiw

tapsirmasinin’ sheshimin izlew,

sheshiw jollarin islep shiǵiw

-Individual ha’m toparlarda islew

-Aniq sheshim jollarin islep shiǵiw

-ha’r bir sheshimnin’ imka’niyatlarin ha’m

tosiqlarin analizlew

-Bir sheshimdi tan’law

4-basqish: Keys sheshimin

rawajlandiriw ha’m tikarlaw,

prezentaciya qiliw

-Jeke ha’m toparlarda islew

-Tan’lanǵan duris variantti a’meliyatta

qollaw imka’niyatlarin tiykarlaw

-Joybar prezentaciyasin tayarlaw

-Aqirǵi qulasa ha’m sheshimnin’ a’meliy

aspektlerin jaritiw

“Baсekelesiw” metodı

“Basekelesiw”  metodı qanday da bir tema boyınshsa talim alıwshılar menen

óz-ara tartıslı, pikir almasıwlar tárizinde ótkiziletuǵın oqıtıw metodı. Hár qanday

tema hám problemalar payda bolǵan bilimler hám tájriybeler tiykarında mihokama

qiliw názerde tutılǵan halda bul metod qollanıladı. Basekelesiw basqarıp barıw

wáziypası  tálim alıwshılardıń birge tapsırıwı yaki  tálim beriwshinıń ózi alıp barıwı

múmkin. Basekelesiw erkin túrde alıp barıwı  hám hár bir tálim alıwshını

Basekelesiwge tartıwga háreket etiw lazım. Bul metod alıp barılıp atırǵanda tálim

alıwshılar arasında payda bolǵan kelispewshiliklerdegi máselelerdiń tez sheshimin

tabıwı lazım. “Basekelesiw”  metodı ótkiziwde tómendegi qaǵiydalardı amelge

asırıwı kerek:
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-bárshe tálim alıwshılar qatnasıw ushın imkaniyat jaratıw kerek.

- “on qol” qaǵiydası(qoldı kóterip, ruxsat alǵannan soń sóylew) na ámel qılıw

- bildirilgen pikir-ideya baseke alar takrarlanbaslıǵı hám óz-ara húrmet

“Basekelesiw”  metodı basqıshları tómendegılerden ibarat:

1. Tálim beriwshi baseke temasın tańlaydı hám soǵan baylanıslı sorawlar islep

shıǵadı.

2. Tálim beriwshi tálim alıwshılarǵa problema boyınsha soraw beredi hám

olardı basekege shaqıradı.

3. Tálim beriwshi berilgen  sorawǵa bildirilgen juwaplardı yaǵniy túrli ideya

hám pikirlerdi jazıp baradı yaki ol wáziypanı orınlaw ushın tálim alıwshılardan birin

ekspert etip tayınlaydı. Bul basqıshta tálim beriwshi tálim alıwshılarǵa óz pikirlerin

erkin bildiriwge  sharayat jaratıp beredi.

4. Tálim beriwshi tálim alıwshılar menen birgelikte bildirilgen pikir hám ideya

toparlarǵa ajratılıp birge analizleydi.

5. Analizlewge qoyılǵan temanı problemanın en maqul sheshimi tabıladı

Basekelesiw metodinin’ du’zilisi

“Basekelesiw”  metodı  áhmiyeti:

-tálim alıwshılardı erkin pikirlewge shaqıradı,

- tálim alıwshılar óz pikirin durıslıǵın dálıllew háreket qılıwǵa imkaniyat

jaratadı,

Mashqalali soraw tan’lanadi

Tu’rli pikirler tin’lanadi

Pikir ha’m ideyalar toplanadi

Analiz qilinadi

Aniq ha’m duris sheshimdi qabil qiliw
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- tálim alıwshılarda tıńlaw hám analiz qılıw qábiletin rawajlandırıwǵa járdem

beredi

“Basekelesiw”  metodı kemshilikleri:

-tálim beriwshiden joqarı basqarıwdı talap etedi.

-tálim alıwshılardıń bilim dárejesine say hám qızıqlı bolıw tema tanlaw talap

etedi.

“Jelpiwish”    usılı

«Jelpiwish»    texnologiyasınan    paydalanıp,    studentlerde:

-jumısqa  dóretiwshilik    jandasıw;

-mashqalaǵa    dıqqatın    jıynay    alıw,

-kerekli    qararlardı    qabıl    ete    alıw    sheberligin    asırıw    múmkin.

“Túsinikler    analizi”    usılı

Túsinikler Bul    túsinik    qanday

mánisti    ańlatadı

Qosımsha    maplıwmat

Interaktiv

algoritmlik    til

Software

Programma

“3x4”    metodı

“3x4”    metodı - talaba    studentlerdi    erkin    pikrlewi        keń    sheńberde

hár    qıylı        ideyalardı    bere    alıwı,    tálim    processinde    jalǵız,    kishi

gruppa    halda analiz    etip,    juwmaq    shıǵara    alıwı,    tariyp    bere    alıwıǵa

qaratılǵan.
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“Skarabey”

“Skarabey”    ınteraktiv    texnologiya    bolıp,    ol    talabalarda    pikriy

baylanıslı,    logika,    yadıń    rawajlanıwına    múmkinshilik jaratadı,    qanday

da    mashqalanı    sheshiwde    óz    pikirin    ashıq    hám    erkin    ańlatıw

sheberligin    formalantıradı.    Usı    texnologiya    talabalarǵa    ózbetinshe    túrde

bilimniń    sapası    hám    dárejesin    holis    bahalaw,    úyrenilip    atırǵan    tema

haqqındaǵı    túsiniklerin    anıqlaw    imkaniyatın    beredi.  Ol  usı  waqıtta,  hár

qıylı  ideyalardı  ańlatıw  hámde  olar  arasındaǵı  baylanıslılıqlardı  anıqlawǵa

múmkinshilik  jaratadı.  “Skarabey”  texnologiyası  hár  tárepleme  bolıp,  odan  oqıw

materialınıń  hár  qıylı  basqıshların    úyreniwde  paydalanıladı:

- basında-oqıw  iskerligin  xoshametlew  sıpatında  (“Aqliy  hújim”);

- temanı  úyreniw  processinde - onıń  mánisi,  dúzilisi  hám  mazmunın

beligilew;  olar  arasındaǵı  tiykarǵı  bólimler,  túsinikler,  baylanıslar  xarakterin

anıqlaw,  temanı  jáne  de  tereńirek  úyreniw,  jańa  táreplerdi  kórsetiw;

- aqırında - alınǵan  bilimlerdi  bekkemlew  hám  juwmaqlaw  maqsetinde.

«Skarabey»  texnologiyası  talabalar  tárepinen  ańsat  qabıl  etiledi,  sebebi  ol

iskerliktiń  pikirlew,  biliw  qásiyetlerin  inabatqa  alınǵan  halda  islep  shıǵılǵan.

Ol  talabalar  tájiriybesinen  paydalanıwdı  názerde  tutadı,  reflektiv      baqlawlardı

ámelge asıradı,  aktiv  dóretiwshilik  izlew  hám  pikriy  tájiriybe  ótkeriw

múmkinshiliklerine  iye.

I-BAP boyınsha juwmaqlaw

Bul bapta tomendegilerdi anıqlap aldıq: hazirgi waqıtta multimedialı оqıw resursları

boyınsha islengen jumislar analizlendi; multimedia tusinigi mısallar menen

korsetildi;  multimedia elektron oqiw resurslarının dasturiy ham apparatlıq

taminleniwi sıpatlap berildi; oqıtıw processinde optimal bilim beriwde multimedialı

interaktiv talim usıllarını paydalanıw algoritmi islep shıgıldı.
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II-BAP. Kompyuter grafikası hám  onıń túrleri

§2.1. Adobe Phoroshop  dasturinde kórinisler jaratıw

«Kompyuter grafikası» túsinigi informatikada júdá keń mániste qollanıladı.

Shet el ádebiyatlarında bul menen bir qatarda jáne «Mashina grafikası» hám

«Mikrokompyuter grafikası» atamaları da qollanıladı. B.Giloydıń pikirinshe,

«mashina grafikası» ataması esaplaw mashinası tárepinen grafikalıq obektlerdi

generaciyalaw, usınıs etiw, islep shıǵarıw yáki bahalaw, ol menen manipulyaciya

etiw hámde grafikalıq obektler hám fayllarda bolǵan grafikalıq emes obektler

arasında baylanıslar ornatılıwın bildiredi. Mashina grafikasınıń dáslepki sistemaları

birinshi sanlı kompyuterler menen birge payda bolǵan.

Grafikalıq maǵlıwmatlardı qayta islewdiń úsh baǵdarı bar:

· kompyuter grafikası;

· súwretlerdi qayta islew;

· kórinislerdi sáwlelendiriw (распознование изображений).

Kompyuter grafikası – bul informatikanıń tiykarǵı bólimleriniń biri bolıp, ol

súwretlerdi payda etiw, qayta islew hám olardı saqlaw usılların úyrenedi. Bul insan

kóriw qábilieti arqalı qabıl ete alatuǵın barlıq túrdegi hám kórinisindegi súwretlerdi

kompyuter yadında súwretlewdi óz ishine aladı. Kompyuter grafikası

paydalanıwshılar ushın ápiwayı bir instrument bolıp xizmet etsede, biraq onıń

strukturası hám usulları fundamental hám ámeliy pánler jetiskenliklerine

tiykarlanadı. Sonıl ushın kompyuter grafikası informatika hám kompyuter

texnikasınıń eń tez rawajlanıp atırǵan tarawlarınan biri bolıp qalmaqta.Kompyuter

grafikası programmasınıń biri Adobe Photoshop programması esaplanadı. Adobe

Photoshop programmasınıń islep shıǵılǵan sánesi hesh bir kalendarda

belgilenbegen. 1987 fevral ayında, «Adobe» kompaniyası, súwretshiler, fotograflar,

dizaynerlar arasında házirge shekem belgili bolǵan «Photoshop — 1. 0» avtorın

járiyaladı. Photoshop programması búgingi kúnde, «kompyuter grafikası» tarawı

boyınsha eń aldınǵı orında turıptı hám bólek programma bolıp ajıraldı. Adobe

Photoshop programmasınıń múmkinshilikleri keń bolıp, kitaplar, gazeta hám
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jurnallardı hár qıylı súwretler menen bayıtıwda  úlken qolaylıqlar jaratadı. Adobe

Photoshop programması 20 dan artıq formatdaǵı fayllar menen islew

múmkinshiligine iye. Eń kóp qollanılatın format : 29 BMP - Windows ortalıǵında

isleytuǵın kompyuterlerde ekran astı suwretlerin qollawshı  programma Microsoft

Paintda keń qollanıladı. JPEG - házirgi kúnde eń kóp qollanılatın formatlardan biri

bolıp, onıń tiykarǵı ábzallıqlarınan biri arnawlı programma járdeminde fayl kólemin

jeterlishe tıǵızlaw  imkaniyatınıń bar ekenligi bolıp tabıladı. Biraq fayldı tıǵızlap,

kólemin kishireytiw processinde suwret sıpatında  ózgeris boladı. Fayl kúshli

tıǵızlanǵanda suwret sapası tómenlewi múmkin. Usı formatdaǵı fayllar kompyuter

yadında kóp orın iyelemeydi hám kólem tárepinen kishiligi sebepli usı formatdaǵı

suwretler menen islew ańsat boladı.TIFF - bul formatdaǵı fayllar da keń qollanıladı.

Lekin tiff formatındaǵı fayllar kompyuter yadında kóp orındı iyeleydi. Adobe

Photoshop programmasında usı formatdaǵı suwretler menen islewde programmanıń

islew tezligi sezilerli túrde tómenlewi múmkin. GIF - usı formatdaǵı kórinisler 256

túrdegi reń menen suwretlenedi. Bul formatdaǵı suwretler, tiykarınan, internet

sistemasında keń qolanıladı.Endi Adobe Photoshop programmasın paydalanıp

mısallar islep kórsetemiz.

Rastrlı grafik redaktorında kórinis jaratıw hám olarǵa islew beriw. Bul

shınıǵıwdı orınlawda Rastrlı grafik redaktorı Adobe Photoshop dástúri

imkaniyatlarınan paydalanıp Tábiyat kórinis jaratamıw kerek.

Adobe Photoshop dástúrinde islew izbe-izligi tómendegishe:

1. Пуск => Программы => Photoshop CS6 iske tu’siriledi.

2.Eni 500 pixel, biyikligi 400 pixel  bolǵan jan’a fail jaratamiz. Jan’a qatlam

jaratamiz Shift+ctrl+N ham oǵan “Back green”  dep at qoyin’.
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Qatlamdi paint Bucket tool uskenesi jardeminde toq jasil
ren’  boyan’. Maselen ren’ kodi #2A690B bolsin.

Ren tańlanǵanan son back green qatlamımızǵa 1 ret basamiz.

Son’ 500 diyametrli jumsaq kistti alin’. ren’in ashiq jasil #4F9F27 ǵa
o’zgertemiz. Joqari shep muyeshke kistti bir ret basin’. Natiyje quyash nuri qalin’

toǵaydi jaritip atirǵanday koriniske iye bolsin.

Son’ jane #D4F14D ni tan’lan’ ksit o’shemin 400 px ge shekem kemeytirin’ Jane
sol joqari shep muyeshke bir marte basin’.
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Kist ren’in #163D03 toq jasilǵa o’zgertin’ diyametr o’lshemin 500 px qilip
belgileymiz ha’m to’mengi on’ mu’yeshke bir marte basamiz.

Su’wret foni tayar. Endi jana qatlam jaratamiz, oni Leaves dep at qoyamiz, bul
qatlam bizge terek japraqlarin siziw ushin za’ru’r.

Kist tur’erinin’ arasinan japraqti tan’lan’, kist o’lshemin 55, aktiv aktiv ha’m
passiv ren’lerdin’ ekewide #385F16

Window>Brush
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Brush aynasinan ozimizge qolay qilip sazlap alamiz.

Endi Burn uskenesin alamiz. Kisttin’ ren’ ha’m o’lshemlerin
o’zgertpegen halda suwrettin’ joqari on’ tareptegi japraqlardi toqraq qilip

boyaymiz.

Keyin Dodge uskenesin alamiz joqari shep mu’yeshtegi
japraqlardi aqshilraq etip boyaymiz. Sebebi keyinshelik quyash nurlari sol jerden

taralıp turadı.

Back green ha’m japraqlar qatlami arasinan jan’a qatlam payda etemiz. Oni Small
leaves dep ataymiz. 35 px o’lshemdegi toq jasil renli kist jardeminde arqa fonǵa
mayda japraqlar sizamiz. Ozimizge qolayli etip Burn uskenesi jardeminde Exposure
= 20 % menen japraqlardin’ ayrim boleklerin toqraq ren’ge boyaw mu’mkin yamasa
Opasity darejesin 65-50%  ge shekem kemeytiriw ha’m mumkin.
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Jasil maysalardi siziwdi baslaymiz. Back green ham small leaves qatlamlari arasinan
jan’a qatlam payda etemiz. Ham oni Grass dep ataymiz. Jasil maysa  sho’p
ko’rinisindegi kistti tan’laymiz. O’lshemin 70 ren’lerin #A4D479 ha’m #385 F16
qilip ornatamiz. Bu; kist jardeminde bir neshe qatar otlardi sizamiz. Suwrettin’ en’
to’mengi bo’legin bos qaldiramiz. Otlarǵa tabiyiy ko’rinish beriw ushin Brush
sazlamalarin o’zgertsekte boladi.

Endi sol qatlamlardin’ o’zinde 112 o’lshemli #629633 ham #1B3405

Ren’lerdegi ksit penen suwrettin’ to’mengi bo’legine otlar sizin’. Bul en’ birinshi
qatardaǵI maysalar boladi.

Small leaves ha’m Grass qatlamlari arasinda jan’a qatlam payda etin’. Oni

Light dep ataymiz. Gradient uskenesin alin’ ha’m yarim shaffof
gradiyentti (basinan ekewin) tan’lan, eki ren’di ha’m #FFFED5 ǵa o’zgertin’.
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TiykarǵI jumisshi saxasina qaytin’ shepten ushinshi gradiyentni tan’lan’ ha’m jane
ren’ maydanina basin’.

Parametrlerdi tap suwrettegidey etip o’zgerttirin’ bul orinda juda abaylan’, ha’r bir
mayda detaldi ko’zden qashirman’.

Amellerdi orinlap bolganimizdan son quyash fonin tu’siremiz.

Filter>Render> Lens
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Layerdiń Backgraundınan Lightqa ótip Gradienttiń úshinshi buyrıǵın tańlap
bolıp suwretimiz ústinen bir márte sızıp nur túsiremiz hám layerdin normal qásiytin
luminosityge ózgertemiz. Endi nurımızdı sál juqalaw túsiretuǵın bolsaq
opacity100% еш 50%ke azaytamız.

Nátiyjede kórinisimiz tayar boldı.

3. Fayl menyusı,Сохранить как komandası ja’rdeminde fayl atın  « 1-

ámeliy.psd» atı menen qálegen jerińizde   papka  jaratıladı ha’m  fayl saqlanadı.
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Adobe Photoshop dástúrinde reńler hám tekstler menen islew.Bul

shınıǵıwdı orınlawda Rastrlı grafik redaktorı Adobe Photoshop dástúri

imkaniyatlarınan paydalanıp Text jazıwın jazıp reńler palitrası menen islew berip

kórinisin ózgertemiz.

Adobe Photoshop dástúrinde islew izbe-izligi tómendegishe:

1. Пуск => Программы => Photoshop CS6 iske tu’siriledi.

500x500 o’lshemdegi 72 dpili jana fail jaratip alamiz. Qalegen so’zin’izdi jazin’.

Tekstti Rasterize type qilamiz. Buni sloy aynasinan text jazilgan sloydin’ ustine

barip on tuymesin basip soljerde sol buyriqti tan’laymiz ha’m sloydan nusqa alamiz

(Ctrl+j). Tekst jazilǵan sloydin’ bos jerlerin oq ren’ menen boyaymiz. Buni orinlaw

ushin Edit>Fill (use. White; Mode; multiply)

Bul rasterize type ...

Edite>Fill…
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2. Ameldi orinlap bolǵanimizdan son’ ekinshi text sloydi NIVIDIM qilip qoyamiz.

Text sloydi buldiratamiz. >Blur >Gaussian blur (radius 3.7)

Keyingi ameldi orinlaw ushin sloydi tortmuyeshli kordinatalar sistemasina otkeriw
lazim. Filter>Distort>Polar coordinates (Options: polar to retangular)
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Sloydi saat strelkasi boylap 900 ǵa aylantiramiz ha’m oǵan to’mendegi filterlerdi
qollaymiz. Filter>Stylize>Wind Filterdi jane bir marte qosamiz Ctrl+F.

Ko’rinisti invertlaymiz. Ctrl+I

Jane bir marte shamal filterin qollaymiz. Filter> Stylize > Wind. Takrarlaw
ushin Ctrl+F ini basamiz. Keyinala suwretti 90 0 gradusqa aylantirip qoyamiz yaǵney
burinǵi halina qaytaramiz.
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Kordinatalar sistemasin o’z halina qaytaramiz. Filter>Distrort>Polar
ordinates (options: rectangular to polar). Sloy rejimin hard lightqa o’zgertemiz.

Ren’ palitrasin o’zgertemiz. Image>Adjust>Hue/Saturation “colorize” rejiminde
qiymatlarin o’zgertemiz. Keltirilgen misalda Hue =32 Saturation=79 qilip

ornatamiz.
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Nátiyjede tayar bolǵan Text jazıwımız kórinisi

3. Fayl menyusı,Сохранить как komandası ja’rdeminde fayl atın  « 2-

ámeliy.psd» atı menen qálegen jerińizde   papka  jaratıladı ha’m  fayl saqlanadı.

Adobe Photoshop dástúrinde kórnislerge qayta islew beriw. Bul

shınıǵıwdı orınlawda Rastrlı grafik redaktorı Adobe Photoshop dástúri

imkaniyatlarınan paydalanıp tayar stakan suwretine suw tamshıların payda etemiz.

Adobe Photoshop dástúrinde islew izbe-izligi tómendegishe:

1. Пуск => Программы => Photoshop CS6 iske tu’siriledi.

2.Qalegen bir stakannin’ suwretin ashamiz.

Taza qatlam jaratamiz (Shift+ctrl+N) ha’m oni 50 % li ku’lren’ge boyaymiz. Edit -
50% Gray
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Ameldi orinlap bolǵanimizdan son’. Filter > Render > Fibers

Amelin orinlap bolǵanimizdan son’ Filter >Blur>Gaussian Blur

Ctrl+L jardeminde biraz kontrasliq qosamiz. Eki shettegi basqariw tu’ymelerin
ortaǵa qarap tartamiz.
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Natiyje to’mendegi ko’riniske iye boladi.

Filter>Filter gallery>texture>Stained Glass payda etpekshi bolǵan suw tamshilar
o’lshemlerin usi jerden ornatamiz.

Ameldi orinlap bolǵanimzdan son OK tuymesin basip. Son’ jane

Filter >Filter gallery> Skatch > Plaster

Magic wand tool u’skenesin alip qara ren’ u’stine bir marte
tishqanshanin’ shep tu’ymesin basamiz, son’ klaviyaturadan DELETE tu’ymesin

basin’.
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Ctrl+D

Olardi biraz deformatsiyalaymiz. Bunin’ ushin CTRL+T ni basip tishqanshanin’
on’ tuymesin basip Deformatsiya (Wrap) buyriǵin tan’laymiz. Tamshilardi stakan

ko’rinisine saykesleymiz. Son’ ENTER.

Bunda wrap buyriǵi Ctrl+T basqannan son’ payda boladi.

Sloy rejimin Overlay ǵa o’zgertemiz. Easer tool uskenesi jardeminde tamshilardin
shala qap qoyǵan jerlerin oshirip shiqsan’iz boladi.

Nátiyjede tamshı payda bolǵan stakanımız kórinisi tómendegishe

3. Fayl menyusı,Сохранить как komandası ja’rdeminde fayl atın « 3-ámeliy.psd»

atı menen qálegen jerińizde   papka  jaratıladı ha’m  fayl saqlanadı.
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§2.2. Animaciya dasturlerinen paydalanıw

iSpring Kinetics dasturi. iSpring Kinetics aynasın ashıp  onnan Книга bántin

tańlaymız.

Книга bólimin  tańlaǵanımızdan  soń  usınday  ayna  payda  boladı.

Bul  aynada  kórsetilgen  kitap  betlerin  ózgertiw  múmkin  boladı.  Bunıń  ushın

joqarıda  kórsetilgen  eki  menyuКнига hám Помощь jaylasqan  bolıp  olardan Книга

menyusına  kiremiz hám Фоны страниц ti  tańlaymız. Bul jerde biz  kitaptıń  fonın

ózgertiwimiz  múmkin  boladı.

Bul  aynada  jáne  biz  kitaptıń  betin  ózgertiwimiz  múmkin.  Bunıń  ushın

Biz ǵa kirip  onda  4  túrli  kórinis  berilgen.  Olardan  siz  ózińizge

unaǵanın  tańlap  alıwıńız  múmkin  boladı.

Kitap  betin  ózgertkenimizden  soń  oǵan  tekst  jaylastırsaq  boladı.  Bunıń  ushın

biz  sol  aynada  kórinip  turǵan bólimine  kirip  ol jerde  biz  tekst  kiritiwimizge boladı.
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Tekst  jazǵanımızda  bizge  kerek  bolatuǵın usı  ayna

da  bar. Egerde  siz  usı  aynadan  aldın  birde-bir  maǵlıwmat  kiritiwińiz  kerek  bolsa,

onda  bunday  qılıwıńız  kerek  boladı.Usı  aynada  biz               payda  bolǵan  tekstli

aynamızdan  aldın  yamasa  keyin  qandayda  bir  tekst  yamasa  basqa  nárse

kiritpekshi  bolsańız  usı  aynanı  bassańız  boladı. Bul  programmada  tekst  jazıwdan

tısqarı  súwret  jaylastırıwǵa  da  boladı.  Bunıń  ushın  dáslep  usı  aynadan

bántin  tańlap alamız  hám  súwret  jaylastıramız. Bul  bólimdi  tańlaǵanımızdan  keyin

usınday  ayna  payda  boladı.

Joqarıdaǵı  aynadan  súwretti tańlap  alıp Открыть ti  tańlap  súwretti  jaylastıramız.

Súwret  usılayınsha  jaylastırıladı.  Eger  sizge  tekst  hám  súwrettiń  arqasındaǵı
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fonnıń  reńi  sizge  unamasa  renin  ózgertseńiz  boladı  hám  ol  usı  aynada  payda

boladı.

Biz iSpring programması  járdeminde  tekst  dúziwdi  baslaymız  hám  kitap

kórinisine  keltiremiz.

Bul  programmadan  keyin  isleytuǵın  jumısımız  usı  aynaǵa  kiriw  boladı.

Bárshe  maǵlıwmatlardı  jaylastırıp  bolıp nı saqlawdı  ámelge  asıramız.

Bul ayna ashılǵannan  soń Сохранить как bólimin tańlap  maǵlıwmattı  bir

at  penen  saqlaymız.
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Usılayınsha  maǵlıwmatlardı  saqlaymız.Maǵlıwmatlardı  saqlaǵanımızdan  soń

onnan  biymálel paydalansaq boladı.

Macromedia Flash dasturi. Programmaǵa  kirgende  ayna  payda  boladı. Onnan

soń  bolsa  kerekli  jayǵa  basıp  ózimizge  zárúr  bolǵan  jayǵa  kiremiz.

Mine  joqarıdaǵı  ayna da  ashıldı. Endi  jumıstı  animaciyadan  baslaymız.

Animatciya tayarlawda  biz  úyreniw  ushın  birinshi bolıp  svetafor  qılıwdı  úyrenemiz

hám  birinshi svetafor  formasın  jasap  alamız. Bunıń ushın biz úskeneler  panelinen

ózimizge  kerekli  bolǵan  formanı  yaǵnıy mine  usı  úskeneler  panelinen  ózimizge
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kerekli  formanı  tańlaymız hám jumıstı baslaymız.

Formanı  jaratıp  alǵanımızdan  soń  oǵan  reń  tańlaymız. Reń  tańlawda  úskeneler

panelinde  berilgen. Ózimizge  kerekli  reńdi  tańlaw  ushın  biz nı  tańlaymız.

Onnan  soń  bolsa  biz  jasaǵan  formamız  ishine  jáne  bir  forma jasap  alamız. Bunıń

ushın  biz  jáne  úskeneler  paneline  múrájat  etemiz. dı  tańlap  alamız  hám  forma

jasaymız. Birinshi bolıp   svetaforimızdı  qızıl  reńli  formasın  jasap  alamız.

Keyin  qalǵan  reńlerdi  tártip  boyınsha  isleymiz. Onnan  soń  bolsa  jasıl

reńli  formanı  jaratıp  alamız.

Bul  formalardı tayarlawda bir-birine ıtıbar berıw kerek  eger qaralmasa formaları

birdey shıqpawı mumkin. Olardıń reńlerıne uskunaler panelinde jaylasqan reńler
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palitrasınan tańlap alıwınız mumkın. Biz paydalanıwshıǵa tusınerlı bolıwı ushın apıwayı

animaciyalardan paydalanıwdı maqul koremiz. Hamme paydalanıwshıǵa tusınerlı boladı

dep oylayman. Sonday qılıp jumisimizdı dawam etemiz.

mıne usı belgini payda qılıwımız ushın biz uskeneler p a n e l ı n e n

nı tańlab sızıp oǵan reń beremiz.

Mıne kórıp turǵanıńızday formalardı payda qılıp aldıq. Áne endi olardı

háreketke keltirip koremiz.

Joqarıdaǵı belgini belgilew ushın basıp formanı belgileymiz.

Jumıstı tamamlaǵannan soń svetaforımızǵa waqıt qoyıp aynalar payda

qılamızLayer aynalarınan izbe-iz korip shıǵamiz.
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Endi ekınshı basqıshtı baslaymız.

Ushınshı basqıshtı baslaymız.

Svetaforımızdıń tayyar halatın korıp shıǵamız.

Mıne  svetaforımız tayyar boldı. Endi Macromedia Flashtı azǵana bolsada

tusınıp aldıq. Onnan soń qıyın formalardı qandayda bir nárselerdiń animaciyasını

qılsaq ta boladı. saqlaw ushın File menyusınan Save bólimine kirip kerekli jayǵa

saqlaymız hám jumństı tamamlaymız.
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§2.3. Adobe Flash dástúrinde hareketli obyektler jaratıw

Macromedia Flash dástúrinde Tábiyat kórnisleri. Macromedia Flash dástúri

imkaniyatlarınan paydalanıp Tábiyat,Taw hám Quyash kórinis jaratamız.

Macromedia Flash dástúrinde islew izbe-izligi tómendegishe:

1. Пуск => Программы => Adobe Flash Professional CS6 iske tu’siriledi.

2. Birinshi qatlam atın Fonǵa ózgertip, tuwrıtórtmúyeshlik instrumentinen
paydalanıp jumıs maydanına reń beremiz .

Keyin Taw kórinisin payda etiw ushın birinshi náwbette Создать слои (Qatlam
jaratıw) bólimin tańlaymız.

Endi Перо instrumentin tańlap taw kórinisin payda etemiz.
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Reń beriw ushın tómendegi kontur hám zalivka nı sáykes ráwishte ózgertemiz.

Nátiyjede

Sonday etip 3-qatlamdı Kún atı menen jaratamız.

Овал instrumentin paydalanıp, Kún kórinisin payda etemiz.

Kúndi sarı reńge boyap oǵan nur beriw ushın Линия instrumentinen
paydalanamız.
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Kun menen nurdı birge belgilep ctrl+g (gruppalaw) operatsiyasın orınlaymız.

Kún qatlamınıń waqıt shkalasınan 1 ge mishka oń túymesin basamız.

Keyin waqıt shkalasınan 75 ke barım kúndi joqarıǵa yaǵniy kúnniń shıǵıw ornına
jaylastıramız.

Endigi náwbetti kún qatlamı qásiyetler qatarınan Поворот bólimin По часовой
стрелке ge ózgertemiz.

Joqarıdaǵı ámellerdi qollap waqıt shkalasınıń 110 ǵa barıp orınlaymız.



53

Tekserip kóriwmiz ushın Ctrl+Enter túymeshesin basamız.

Nátiyjede kórnisi tómendegishe

3. Fayl menyusı,Сохранить как komandası ja’rdeminde fayl atın  « kún.fla» atı

menen qálegen jerińizde   papka  jaratıladı ha’m  fayl saqlanadı.

§2.4.  Delphi multimedia imkaniyatları

Embarcadero  Delphi  10  lite    Microsoft  Windows,  Mac  OS,  IOS  hám

Android  operacion  sistemaları  ushın  programmalıq  táminat  jaratıwda

integrallastırılǵan  vizual  programmalastırıw  tili    bolıp  tabıladı.  Delphi  dáslep

Borland  kompaniyasına  tiyisli  bolıp,  házirgi  waqıtta  Embarcadero  Technologies

tiyisli  bolıp  esaplanadı.  Embarcadero  Delhpi,  Embarcadero  RAD  Studio  nıń

bir  bólegi  bolıp  tabıladı.  Delphi  vizual  programmalastırıw  tilin  islep  shıǵıwda

Kanada  hám  Ispaniyada  jaylasqan  Embarcadero  ofisi  juwapker  esaplanadı  .
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Delphi  10  programmalastırıw  tilinde  test  jaratıw  texnologiyası.

Taza  forma  jaratıwda  File->New->VCL  Forms.Application – Delphi  for  Win32

buyrıqlar  izbe-izligi  orınlanadı.

Bul  buyrıq  izbe-iz  orınlanǵannan  keyin  Delphi  10  lite  ta  taza  Forma

payda  boladı.  Onıń  atı  standart  túrde  Form1  dep  ataladı.

Object  Inspector  bóliminen  forma  ólshemlerin  kiritemiz.

ClientHeight  (forma  biyikligi)  =  600

ClientWidth  (forma  eni)  =  800

Bul  formada  test  jaratıw  ushın
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Tool  Palette  (Instrumentler  palitrasınan)->Win32->TPageControl  komponentasın

formaǵa  sáykes  jaylastıramız.

Shıǵıw  túymesin  jaratıwda  Additional  bóliminen  TBitBtn komponentasın

TPageControl1 komponentasına mishka oń túymesin basıp, kontekstli

menyudan New Page (taza bet) qosıwdı tańlaymız. Usınday etip 3 dana bet atın

sáykes Bas bet, Test, Avtor dep jazamız. Bul jazıwlar TpageControl1

komponentasında kóriniwi ushın TabSheet1 diń Caption qásiyetine jazıw arqalı

ámelge asıramız.
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Keyin Test bólimine ótip, RadioGroup1 komponentasın jaylastıramız.

RadioGroup1 komponentasınıń Caption qásiyetine sorawdı kiritemiz. Al

juwapların Items qásiyetiniń … buyrıǵına jazamız.

Nátiyjede tómendegi kórinis payda boladı.

Jáne test sorawların qosıw ushın RadioGroup komponentasın jaylastıramız.
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Programma iske túskendegi kórinisi:

Delphi úyretiwshi multimedia interfeysi
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II-BAP boyınsha juwmaqlaw

Bul bapta tómendegi máselelerdi kórildi:

Adobe Phoroshop dásturi hám onıń imkaniyantları járdeminde ámeliy máseleler

sheshiw algoritmi islep shıǵıldı  hám nátiyje alındı. Animaciya  dásturleri hám hám

onıń imkaniyantları analiz islenip  3D kitap jaratiw, Power Point hám iSpring

dásturleri járdeminde multimedialıkórinisler jaratiw algoritmi islep shıǵıldı. Adobe

Flash dásturi hám onıń imkaniyantları járdeminde ámeliy jumıslardı orınlaw

metodikası islep shıǵıldı. Delphi diń multimedia imkaniyantları járdeminde

úyretiwshi dástur islep shıǵıldı (Delphi multimedia interfeysi suwrette kórsetilgen).;
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III-BAP. Multimedia elektron oqıw resursların jaratıw metodikası

§3.1. 3D kitap jaratıw

Multimedianıń kirip keliwi informaciya texnologiyaları salasında jańa

dáwirdi baslap berdi. ― “D” termini inglizcha ― “dimensions” sózinen alınǵan

bolıp, ― “ólchamlar” mánisin beredi. 3D texnologiyası suwretti vizual hám dawıslı

uzatib beriwdiń dúnyadaǵı eń aldıńǵı usılı esaplanadı.

Házirgi kúnde úsh ólshemli háykeller, iri ob'ektlerdiń kishreytirilgen

modelleri (mashinalar, samolyotlar, jaylar), sonıń menen birge,hár qıylı ilimiy

islenbeler modellerin soǵıw múmkinshiligi ámeldegi. Onıń ushın álbette 3D

printerlerden paydalanılıp atır.

3D printerler - úsh ólshemli sızılmalar tiykarında zat-buyımlar " baspaǵa

shıǵarıwshı" printerler bolıp tabıladı. Házirshe bul sıyaqlı islenbeler tar sheńberde

ámelge asırılıp atırǵan bolsa, jaqın keleshekte biymálel úy sharayatında 3D-

printerden mısalı bir jup krossovka, kiyim yamasa ruwzıger buyımı shıǵarıp alıwdıń

múmkinshiligi boladı.

Úsh ólshemli baspaǵa shıǵaratuǵın ónimlerdiń narxi tómenlewin inabatqa

alsak, usı texnologiyaǵa talap asıp atır. Búgingi kúnde Boeing kompaniyası óz

samoliyotlarining 200da artıq detallarin 3D baspaǵa shıǵaratuǵın texnologiyası

tiykarında islep shıǵıp atır.
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Házirgi kúnde elektron kitaplar hár-túrli ayırmashılıqlarǵa iye, yaǵnıy oqıwǵa

qolay interfeysli, hár-túrli effektlerdi qosıw, yaǵnıy ózine tartatuǵın flash -roliklerdi,

animaciyalardı hám illyustraciyalardı qollaǵan halda islep shıǵıw zaman talabı

esaplanadı. Elektron kitaplarǵa joqarıda aytıp ótilgen effektlerdi qosıw ushın

mólsherlengen hár-túrli programmalar bar bolıp, sol programmalar arasında

3D PageFlip programması paydalanıwǵa eń qolay programma esaplanadı. Sol

sebepli hár-túrli programmalarda islep shıǵılǵan elektron kitaplarımızǵa hár-túrli

effektlerdi qosıwdı usı programmada kórip shıǵamız. 3D PageFlip programması

aldınan jaratılǵan kitabımız (*. doc, *. docx, *.pdf hám taǵı basqa formatlarında )

yamasa programmanıń ózindegi Demo kitabınan paydalanıp 3D effektli kitabımızdı

jaratamız.
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1 suwret. 3D PageFlip programmasınıń bas aynası

Usı programma tayın súwretlerimiz kompleksine, prezentaciyalarımızǵa hám

elektron kitaplarımızǵa hár túrli effektlerdi beriw ushın mólsherlengen. Programma

bas aynası 'Create New', 'Import Office', 'Demo', '3D Demo' túymeleri hám tayın

proektlerdi ashıw túymelerin óz ishine alǵan. 'Create New' hám 'Import Office'

túymeleri shártli túrde *.pdf hám office programmalarında jaratılǵan hújjetler

yamasa prezentaciyalardı import etiwge mólsherlengen. *.pdf formatındaǵı aldınnan

jaratılǵan «Tálimde xabar texnologiyaları páninen laboratoriyalıq jumıslar» oqıw

stilistik qollanbasına hár-túrli effektlerdi qosamız. Usınıń sebebinen 'Create New'

túymesin basamız hám nátiyjede tómendegi ayna ashıladı :

2 suwret. Taza proekt aynası.
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3D PageFlip programmasıda úsh túrli resurs jaratıwmızǵa boladı. Bular

hújjet, jurnal hám súwretler kompleksi esaplanadı. Biz jurnaldı tańlaymiz hám

nátiyjede tómendegi ayna ashıladı :

3 suwret. Import PDF aynası.

'Import Office' aynasında import etiletuǵın hújjetke jol, qaysı betlerdi import

etiw hám taǵı basqa import sazlawların óz ishine alǵan. Ózimizdiń hújjetimizga joldı

kórsetip 'Import Now' túymesin basamız hám import etiw procesi tamamlanıwın

kútemiz. Nátiyjede programma biziń kitabımızǵa 3D effekt esaplanıwshı

«Paraqlaw» effektin beredi:

4 súwret. Import nátiyjesi

Juwmaqlap sonı aytıwmız múmkin, 3D PageFlip programması tekǵana

«paraqlaw effektin», bálkim multimedia faylların hám basqa 3D effektlerdi qosıw

imkaniyatın da beredi.
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§3.2. Bilimdi bahalaw testlerin jaratıw

EasyQuizzy  programmasi  bul  test  duziwshi  programmalar  ishinde

paydalaniwshiǵa ansheli  darejede  qolayli  programma  bolıp  esaplanadı.

EasyQuizzy  atamasi  ingliz  tilinen  alinǵan  bolip  “easy-ańsat,  quizzy-viktorina”

sózlerinen  kelip  shiqqan  yaǵniy  ańsat  viktorina  degen  manisti  ańlatadı.

EasyQuizzy  programmasın

uustanovka etiw ushın 2easyQuizzy-

2.0-installer.exe tańlanadı hám

“Установить” tyumesi  basıladı.

EasyQuizzy  programması  jumıs aynası

tómendegi kóriniske iye.

Programma menyuler qatarı Файл, Правка, Вид, Вопросы, Вставка hám

Справка lardan ibarat.

Jumisshi  maydanı  3  bólimnen ibarat boladı.

1. Информация  о  тесте

2. Вопросы  и  ответы

3. Настройки  теста

1. Информация  о  тесте  (Test  haqqinda  maǵlıwmat)  bunda  bizler  tiyisli

tarawımızǵa  yaki  pange  baylanisli  sorawlarimizdi  kiritemiz.

Информация  о  тесте  3  bólimnen ibarat bolıp, olar  Название  теста,

Описание  тест  ham Автор. Olarǵa  qisqasha  maǵliwmat  kirip  ketemiz.
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Название  теста  (Test  ataması) - bul  jerge  bizler  testtiń  qaysi  pange

tiyisli  ekenligin  yagniy  oniń  atamasin  kiritiwimiz  kerek  boladı.

Описание  тест - bul  jerge  test  haqqinda  maǵliwmatlardi kiritiwimiz

kerek  boladı.  Yaǵniy  oniń  neshe  soraw  ekenligin  test  ushın  neshe  minut

ajratilǵan  ekenligin  aniq  etip  kiritip  ketiwimiz  kerek  boladı.

Автор  (Avtor) – bul  tez  dúziwshiniń  kim  ekenligin  keltirip  ketemiz  yaǵniy

avtor.

EasyQuizzy  programmasındaǵı

keyingi  ayna Вопросы и

ответы aynası.

Bul  maydan  testke  tiyisli

soraw  hám  juwaptı  kiritiw

ushın  arnalǵan  ayna

esaplanadı.

Eń  birinshi  joqarıdaǵı  buyruq  “Tип  вопроса”  bunda  bizler  testti  qanday

kóriniste  dúziwimizdi  belgilep  alamız.  Oniń  tiykarinan  6  túri  bar

1. Алтернативный  выбор

2. Выбор  одного  правильного

ответа

3. Выбор  нескольких

правильного  ответов

4. Установление  правильной

последовательности

5. Установление  соответствия

6. Свободный  ответ

Bulardiń  hár  birine  túsinik  berip  ótemiz.
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1. Алтернативный  выбор – bunda  kiritilgen  sorawdıń  juwabi  tek  eki  túrde

berilgen  boladı. Test  duzishi  avtor  anıq  juwaptı  belgilep  ketiwi  kerek  bolip

esaplanadı.  Testti  sheshiwshi oqiwshi  yaki  talaba  oni Да(Awa)  hám Нет(Yaq)

kórinisinde  belgilewi  kerek  boladı.

Bundan  keyin  jumisshi  maydanniń  shep  joqarǵı  tárepinde  saqlanıp

barıladı.

Добавить  вопрос buyruǵına  basip  keyingi  sorawdı  kiritip  ketiwimizge boladı.

2. Выбор  одного  правильного  ответа – Bunda  testti  aniq    bir

juwabin  kiritiwimiz  kerek  boladı.  Sorawdıń  juwabiniń  variantları  ózimiz

qalgenshe  etip  belgileymiz.  Tiykarinan  eń  keń  tarqalǵanı  3  variantta  juwaplar

beriledi.

3. Выбор  нескольких  правильного  ответов - Eger  berilgen

sorawdiń  juwabi  bir  emes  bir  neshe  juwapqa  iye  bolsa  qollaniwimiz

múmkin.  Bunda  testti  sheshiwshi  yaki  paydalaniwshi  juwapti  egerde  barligi

duris  bolsa  barliq  juwapti belgilep  huquqina  iye.
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4. Установление  правильной  последовательности – bunda  sorawdiń

juwabı  durıs  izbe-izlikte  belgilewimiz  kerek  boladı.  Testti  sheshiwshi  adam

juwapti  belgilegende  izbe-izligin  aniq  etip  belgilewi  kerek.  Eger  izbe-izlik

buzilsa  berilgen  juwap  qate  esaplanadı.

5. Установление  соответствия - bul  sorawlar  toparlarǵa  ajratip

beriledi.  Yagniy  bir  sorawdin  ishinde  bir  neshe  sorawshalar  berilgen  boladi.

Bunda  da  barliq  sorawlarga  duris  juwap  beriw  kerek  boladi.  Maselen  berilgen

sorawlardin  biri  qate  juwap  berilgen  bolsa  bul  juwap  duris  dep  qabil  etilmeydi.

6. Свободный  ответ – bul  atınan  belgili  bolip  turǵanınday  erkin

juwap  dep  ataladı.  Misalı  berilgen  sorawdiń  juwabın  paydalanıwshı  ózi  kiritedi

yaǵniy  ol   jazıw  kórinisinde  beriledi.
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Bizler  EasyQuizzy  programmasinda  test  duziwdiń  6  usili  menen  tanisip

shiqtiq.  Endi  bizler  usi  duzgen  testlerimiz  saqlaw  ham  paydalaniwshılarga

jetkerip  beriw  ushın  oniń  parametrlerin  tuwrılap  alıwımız  kerek  boladı.

EasyQuizzy  programmasında  Настройки  теста buyrugında  amelge

asırıwımız  mumkin.

Настройки    теста - EasyQuizzy  programmasiniń  tiykarǵı  3  bóliminiń

biri  bolip  esaplanadi.  Bul  jerde  tayyar  testtiń  parametrlerin  kiritiwimiz  kerek

boladi.  Ol  tómendegi  kóriniske  iye.

Bunda eń  joqarǵi  bóliminde  “Количество  задаваемых  вопросов”  eki

turge  bólingen.  Olar  “Все  вопросы”    ham  “Случайные вопросов”.

“Все  вопросы” - Bul  jerde  barliq  sorawlardi  bizge  sheshiwimiz  ushın

shigarip  beredi.  Yagniy  sorawlar  sanı  qansha  boliwinan  qaramastan  ol  sonsha

sorawdi  paydalaniwshi  sheshiwi  ushın  beriledi.

“Случайные вопросов” – Bul  sorawlardiń  sanın  ózimiz  belgileymiz

yagniy  bizde  100  soraw  bolsa  bizler  30  sorawliq  kerek  bolsa  usi  jerge  30 di

kiritip  ketemiz  ham  bizlerge  30  sorawliq  etip  testti  shigarip  beredi.

“Задавать  вопросы”  ham “Предлагать  ответь” – bul ekewi 2  ge

bólingen.
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“В  случайной  порядке” - Sorawlar  tosattan  beriledi  yagniy  aniq  bir  izbe-

izlikte  berilmeydi.

“По  порядку” - Sorawlar  tartipli  izbe-izlikte  beriledi.

“Система  оценивание” – Bul  bahalaw  sistemasi  bolip  oni  qanday  etip

bahalawdi  kerek  ekenligin  aniqlap  alsaq  boladi.  Oniń  har  turli  usillari  bar.

Olar tómendegiler.

Bizler  talim  beriw  sistemalarinda

kobinese  100  balliq

sistemalardan  paydalanamiz.

“Время” – bul  jerdi  testti

sheshiw  ushın  waqitti  kiritip

ketiwimiz  kerek  boladi.    Waqitti

bizler  qalegenshe  belgilewimiz

mumkin.  Biraq  ol  180  minuttan

ketpewi  kerek  bolip  esaplanadi.

“Резултаты теста” – Bul  testtin

juwmagi.

Testtiń  juwmaǵinda  neshe  bal  alǵan  ekenliginimizdi  biliwimiz  ushın

“Формировать  итоговый  отчёт” belgilep  ketiwimiz  kerek  boladı.

Test  tayyar  bolgannan  keyin  Ctrl+F5  tuymesin  basiwimiz  kerek  boladi.

Testti ózimizdiń  ati  familiyamizdi  kiritip  testti  sheshiwge  baslasaq  boladi.
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§3.3. Multimedia elektron oqıw resursların jaratıw

MS Excel programmasında „Elektron klass jurnal“. Klass jurnalı

Mámleket tálim standartları hámde oqıw dástúrleriniń orınlanıwın kórsetetuǵın

mámleketlik hújjet esaplanadı. Mektep direktorı hám direktor oqıw isleri boyınsha

orınbasarı klass jurnalınıń dúrıs júrgiziliwi hámme waqıt qadaǵalawı hám bul

haqqında jurnalǵa jazıp belgilep barıwı zárúr. Klass jurnalı bir oqıw jılı ushın

arnalǵan bolıp,  har bir mektepte, har bir klassta Ózbekistan Respublikası Xalq tálimi

ministrligi tárepinen tastıyıqlanǵan nusxada júrgiziledi. Pedagogikalıq hám

informaciyalıq texnologiyalar dáwirinde klass jurnalın júrgiziwdiń alternativ

variantların islep shıǵıw zaman talabı. Usı ilimiy metodikalıq maqalada klass

jurnalınıń elektron versiyasın jaratıw algoritmi islep shıǵıldı hám tómendegi

basqıshlardan ibarat. Jurnaldaǵı informaciyalarǵa tiykarlanıp onıń infologiyalıq

modeli islep shıǵıldı(tablica):

Kórsetkishler Mánisler
1.Klass jurnalın paydalanıw múddeti
2.Klasslar
3.Oqıwshılar sanı
4.Pánler
5.Mektep ıqtiyarındaǵı pánler
6.Oqıw rejedegi saatlar kólemi
7.Oqıwshılardıń sabaqqa qatnası
8.Pánler boyınsha sabaqta ne

9.Oqıwshılardıń bilim sıpatı

10. Oqıwshılardıń hulqın bahalaw

11.Pedagogikalıq keńes qararı

12.Oqıwshılar haqqında ulıwma maǵlıwmatlar

t.1. Bir oqıw jili
2.1. I, II, III, ... , X, XI
3.1. XXXX bayt
4.1. XX bayt
5.1. X bayt
6.1. XXXXXX bayt
7.1. XX bayt
8.1. Tema,
8.2. Shınıǵıw
8.3.  Úyge tapsırma
9.1. Sherek
9.2. Yarım jıllıq
9.3. Jıllıq baha
10.1. Úlgili
10.2. Qanaatlandırarlı
10.3. Qanaatlandırarsız
11.1. 5-klassqa kóshirildi
11.2. 11-klasstı tamamladı
11.3. Kúzge qaldırıldı
12.1. Ata-anasınıń ism,
sháripi
12.2. Semya jaǵdayı
12.3. Fizikalıq rawajlanıw
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13.Klass basshısınıń wazıypaları

14. Pán oqıtiwshiları
15. Krujok

12.4. Psixologiya
12.5. Ergonomika
13.1. Har bir oqıw páni
boyınsha  bahalardı kóshirip
o'tkiziwi
13.2. Qaldırılǵan sabaqlardı
esaplaw
13.3. Klass jurnalınıń
saqlanıw hám júrgiziw
qaǵıydaları tiykarında
kúndelik qadaǵalaw alıp
barıw
13.4. Jurnal betlerin pánler
boyınsha bólistiriw
13.5. Jurnalǵa oqıwshılar
dizimin jazıw
14.1. 0-255 bayt
15.1. Matematika
15.2. Fizika
15.3. Informatika
15.4. Biologiya
15.5. Ximiya
15.6. Til hám ádebiyat

Tablica tiykarında Microsoft officetiń MS Excel programmalarınan

paydalanıp maǵlıwmatlar  bazasın dúzemiz[2].  Bul baza klass jurnalına tiyisli

bolǵan matematikalıq, logikalıq hám túrli tarawdaǵi (ekonomikalıq, sociallıq,

ekologiyalıq h.t.b.) máselelerdi sheshiwge imkaniyat jaratadı. Máǵlıwmatlar

bazasın aktuallastırıw hám klass jurnalına tiyisli máseleler ústinde ámeller orınlawda

xabar–kommunikaciya  texnologiyalarınan paydalanıw  imkanyatların keńeytedi

hám jańa vizual programmalardı úyreniwge mektep xızmetkerleriniń potencial

qızıǵıwın arttıradı. Mektepti tolıq sıpatlaytuǵın kórsetkishlerdi anıqlaw hám

aktuallastırıw ilimiy izleniw jumısların alıp barıwdı talap etedi. Biz maqalada

tomendegi máselelerdi sheshiw algoritmin kórsetemiz: oqıwshılardıń sabaqqa

qatnasıw dinamikasın hám pánler boyınsha bilim dárejesin anıqlaw. Bunıń ushın

klass jurnalın MS Excel elektron tablicasın jaratıp alamız. Oqıwshılardıń sabaqqa

qatnasın anıqlaw ushın sabaq grafigi jardeminde hám infologiyalıq modelge
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tiykarlanıp  elektron tablica toltıramız. Tablicada sabaqqa sebebsiz qatnaspaǵan

oqıwshılar “J”, keshigip kelgen oqıwshılar “K” menen belgilenedi. Elektron klass

jurnalın jaratıw algoritmin   Nókis qalasındaǵı № 38 sanlı mekteptiń 6 "D" klass

ushın máselelerdi sheshiwdi kórsetemiz. Elektron tablicada yacheykalardıń

bólistiriliwi:

1.MS Excelde Книга1 kitap  ashılıp “Qatnas” atı menen saqlaymız (Сохранить).

1. Kitaptıń birinshi beti (Лист1) atın  “6-D” dep qayta ózgertemiz

(Переименовать). Sebebi 6”D” klass ushın elektron jurnal dúziledi.

2. B1:Z1 yacheykalar birlestirilip “Nókis qalasi № 38 atli mekteptiń 6 "D" klass

oqıwshıları fevral ayı ushın qatnası” dep jazıladı. Misal ushın fevral ayında

24 oqıw kunine sáykes 24 yacheyka, tártip nómeri hám oqıwshılardıń

familiyasın jazıw  ushın jáne 2 yacheyka kerek boladı. Demek, B1 den AA1

ge shekem bolǵan 26 yacheykanı blokqa alamız hám format menyusındaǵı

Format yacheyka aynasındaǵı выравнивание bóliminiń объединение

yacheyka belgilenedi.

3. D2:AA2 yacheykalar blogına  sabaq  kúnlerine tiyisli sánelerdi jazamız.

4. Sáykes D3:E3, F3:K3, L3:Q3, R3:W3 hám X3:AA3 yacheykalar blokların

birlestirip hápteniń tártip nómerleri jazıladı.

5. B4 yacheykaǵa “T/N”, C4 yacheykaǵa “Familiya hám atı”, D4 den AA4 ge

shekem 24 oqıw kúnine sáykes hapte kúnlerin jazamız.

6. B5:B26 yacheykalar blogına 1 den 22 ge shekem tartip nómerleri jazıladı.

7. C5:C26 yacheykalar blogına 22 oqıwshılardıń familiyası hám atı jazıladı.

8. D5:AA26 yacheykalar blogına oqıwshılardıń sabaq qaldırıwları hám

keshigiwlerine sáykes másele shártindegi (“J” yamasa “K”) belgilerdi, C2

hám C3 yacheykalarǵa usı belgiler mánislerin jazamız.

9. Oqıwshılar sabaq qaldırǵan hám keshigip kelgen kúnlerin kestege belgilep

shıǵamız J hám K háripleri menen belgilep shıǵamız.

10.“J” hám “K” belgileri kiritilgen yacheykalarǵa Вставка menyusınıń

Примечание bólimi yamasa kontekst- menyudiń Добавит примечание
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bólimi járdeminde sabaqqa qatnaspaǵanlıq hám keshigiwge tiyisli  sebep

kórsetilgenin jazamız.

11. J yamasa K belgisi kiritilgende Добавит примечание bólimi tańlanıp

sebebi kórsetiledi hám usı ketek joqarı múyeshinde úshmúyeshlik belgi payda

boladı bul belgi ústine tıshqansha kórsetkishin alıp barǵanda sebebin

kórsetedi.

12. J hám K belgilerge sebebin kiritiwde olarǵa kiritilgen sózdiń reńin, ólshemin

kiritiwimiz múmkin. Bunıń ushın usı  sózdi blokqa alıp kontekst- menyusiniń

(Формат примечания) bólimi paydalanıladı.

13. Kestedegi máǵlıwmatlardı kóriw qolaylı hám kórgizbeli bolıwı  ushın

yacheykalar bloklarına hár túrli formatlaw imkaniyatların qollawımız

mumkin.

14. Sabaq qaldırǵan hám keshigip kelgen oqıwshılardıń bir kúnlik, bir háptelik

hám bir aylıq qaldirǵan saatları jámin esaplap shıǵamız.

15. Buniń ushın A27:B29 yacheykalardı J-kelmegen oqıwshılar hám A30:C32

yacheykalardı birlestirip K-keshigip kelgen oqıwshılar dep jazıladı.

16. C27, C28, C29 yacheykalarǵa sáykes sol kúngi, bir háptelik  hám  bir aylıq

sózlerin kiritemiz.

17.D27:AA27 yacheykalarǵa  hápteniń hár kúni kelmegen oqıwshılar sanı jazıp

shıǵıladı, D28:AA28 yacheykalar bolsa bir háptelik kelmegen oqıwshılar sanı

jazıladı, D29:AA29 yacheykalar  bir aylıq sabaqqa qatnaspaǵan oqıwshılar

sanı jazıladı.

18.D30:AA30, D31:AA31, D32:AA32 yacheykalar hám sáykes usı kúngi, bir

háptelik  hám  bir aylıq sabaqlarǵa keshigip kelgen oqıwshılar sanı jazıladı.

19.AB27:AB32 yacheykalardı birlestirip Jámi sózin kiritemiz.

Alınǵan nátiyje tómendegishe kóriniste boladı:
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Oqıwshılardıń sabaqqa qatnasıw dinamikası grafigi

Mektep oqıwshılarınıń(6”D” klass ushın) pánlerden 1, 2, 3 hám 4 shereklerde

alǵan, ortasha hám ulıwma jıllıq bahaların esaplaw, hám bilim darejesin kórsetiwshi

elekron klass jurnal jaratıw ushın joqarıdaǵı sıyaqlı elektron tablica toltırıladı. Keyin

tómendegi ámellerdi orinlaymız[1,3]:

1. Sáneler jazılǵan baǵanalardan keyin bir baǵana  bos qaldırıp, 3-qatar

dawamındaǵı izbe-iz yacheykalarǵa “Órtasha baha” hám “I-sherek”, “II-

sherek”, “III-sherek”, “IV-sherek” dep jazamız.
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2. A4 yacheykaǵa tártip nomer, B4 yacheykaǵa oqıwshılardıń Atı hám

familiyası, oqıwshılar bahaların sánelerge hám sáykes yacheykalarǵa jazamız.

3. Sherek bahalardı esaplaw ushın X4 yacheykaǵa Вставка menyusınen

Статистические funkciyalar bóliminen “=СРЗНAЧ(C4:F4)” funkciyasın

tańlaymiz.

4. X4 yacheykalardaǵı sannıń onlıq bólshek bóleginen tek ǵana 3 xanası

kóriniwi ushın Формат menyusındaǵı Формат ячеек interfeys aynasınan

Число bólimin tańlap, soń Числовой bólimindegi Число десятичных

знаков tańlaw yacheykasınan 3 ti tańlaymız.

5. Y4 yacheykaǵa Вставка menyusınıń Математические funkciyalar

bóliminen “=ОКРУГЛ(M4;0)” funkciyasın jaylastıramız.

6. X4 hám Y4 yacheykalarınan tómendegi qatarǵa nusqa alamız.

Nátiyjede 6-klass oqıwshılarınıń bilim dárejesin aniqlaw diagrammasın dúzemiz.

Demek, juwmaqlap aytqanda mektep ushın elektron klass jurnaldan paydalanıp

isletiletuǵın hujjetlerdi jańadan proektlestiriwge, oqıwshılardıń sabaqqa qatnasın

hám bilim dárejesiniń dinamikasın anıqlawda nátijeli boladı. Sonday-aq, ulıwma

bilim beriw mekteplerinde avtomatlastırılǵan oqıtıw sistemasın engiziwge óz úlesin

qosadı.

Elektron tetrad. Informatika  oqıtıwshısı oqıwshılarǵa klassta tapsırma berse ,

oqıwshılar onı tezde orınlap oqıtıwshıǵa kórsetiwge asıǵadı. Oqıtıwshı klass

oqıwshılarınıń informatika dápterlerin tekserip dúrıs bahalawı tiyis. Sebebi
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oqıwshılar bilimine ǵárezli bolǵan bahanı óz waqtında alıwı kerek.Oqıtıwshınıń

búnday tez operativ bahalawǵa kúshi jetpeydi. Oqıtıwshı hárbir oqıwshınıń ámeliy

jumıs ushın ajıratılǵan qaǵaz dápterindegi tapsırmalardı(algoritm dúziw, krossvord

sheshiw,programma tekstin analizlew h.t.b.)   cifrlı yamasa sóz formasında bahalawı

tiyis. Bul jerde eki másele kelip shıǵadı:

1.Oqıwshılardıń ata-anası qaǵaz dápterdi eskertpesten satıp alıwǵa májbúr.

2.Sabaqtan soń dápter tekseriw oqtıwshınıń waqtın aladı.

Eger oqıwshı tapsırmalardı kompyuterden paydalanıp orınlap “Tekseriw”

knopkasın bassa, kompyuter ózi juwaptıń dúrıs yamasa nadúrıs  ekenligin kórsetedi.

Sonday-aq, kompyuter  oqıwshı neshe ret dúrıs juwap berdi, qanday tapsırmanı

kórdi, biraq orınlamadı, ótkizip jiberdi hám t.b. parametrlerdi kompyuter esaplaydı.

Demek, kompyuter informatika oqıtıwshısın dápter tekseriwden,  artıqsha kúsh

júmsawdan hám waqıttan azat etedi. Oqıwshılar bir páste  ozine tiyisli bahaların

aladı. Kompyuter  hárbir oqıwshı ushın  jeke informatika oqıtıwshısı boladı.Sabaq

processinde jańa materiyallardı túsindiriw, oqıwshılar bilimin obektiv bahalawdı

avtomatlastırıw texnologiyasın islep shıǵıw magistrlik dissertaciya jumısınıń

wazıypası esaplanadı. Ámeliy sabaqlardı avtomatlastırıw  tómendegi máselelerdi

sheshiwge alıp keledi:

-hárbir oqıwshınıń kúshli hám álsiz táreplerin kóriw;

- oqıwshılardıń bilim dárejesin, úqıplılıǵın, kónlikpesin  anıqlaw;

-oqıtıwdıń optimal variantın saylaw;

- oqıwshılardıń oqıw materialların  ózlestiriw boyınsha iskerlik jumısların

xoshametlew;

- oqıwshılardı bahalawda jeke faktorlardıń (tanıs- biliwshilik, abıroyǵa ata-anasınıń

h.t.b.) áhimiyetin azaytiw;

-sabaqta waqıttı tejemli paydalaniw;

-oqıw tapsırmaların tayarlawda  ózińniń waqtıńdı tejew;

-oqıwshılar menen oqıtıw processinde tezde keri baylanısta  bolıwdı

támiyinlew(túsindiriw, sorawlarǵa juwap beriw, bahalaw h.t.b.);

-úlken kólemli oqıw materiyalların iyiliw;
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-qaǵaz materiyallardı yamasa tarqatpa materiyallardı paydalanbaw.

Bul programma materiyalları 5-11 klasslar ushin arnalǵan “Informatika hám

informacialıq texnologiyalar”  sabaqlıǵına sáykes keledi. Programmanıń

imkaniyatları:

-tayarlanǵan tapsırmalar oqıwshilar ushın túsinikli hám qızıqlı;

- tapsırmalar oqıtıwshilar miynetiniń sapasın kóteriwge baǵdarlanǵan;

-pánniń metodikasın jaqsılawǵa;

-sabaqtı shólkemlestiriw hám ótkeriwdi jaqsılawǵa;

-oqıwshılardıń oqıw iskerligin jaqsılawǵa;

- oqıtıwshılardı tapsırmalardı tekseriwdey awır jumıstan azat etiw;

- oqıwshılardıń bilimin bahalawda járdemlesiw;

- oqıtıwshılardıń  b os waqıtların   optimal paydalaniwǵa múmkinshilik jaratıw.

Islep shıǵılǵan  mashina programması harbir sabaqta  oqıwshılardıń temalardı

ózlestiriwin, olardıń bilim dárejesin pánler kóleminde anıqlawǵa, pánge

qızıǵıwshılıǵın arttırıwǵa hám waqıttı tejewge járdem beredi.Programmada islew

oqıwshılardıń ańlawın, iskerligin,oylawın, yadın, dıqqatın, óz betinshe islewin

rawajlandıradı. Elektron tetrad “Informatika hám informacialıq texnologiyalar”

sabaqlıǵıdaǵı shınıgıwlardı, tapsırmalardı, óz betinshe jumıslardı óz ishine alıp

kompyuter jardeminde tekseriledi. Oqıtıwdıń tiykarǵı áhmiyetli elementi

oqıwshılardıń bilim hám úqıplılıgın baqlaw, bilimdi klassik baqlaw hám bahalaw

formasınan kompyuterli bahalawǵa ótiw boladı. Bul bilimlendiriw sistemasın

kompyuterlestiriwdiń uliwma koncepciyasına  juwap beredi.Oqıwshılardıń bilimin

tekseriw hám bahalaw oqıw tarbiya jumısınıń zárurli bólegi.Onıń dúrıs qoyılıwı

oqıwshılardıń sıpatlı bilim alıwına járdem beredı. Oqıtıwdıń ózgesheligi  óz betinshe

jumıslarǵa, oqıwshılardıń óz-ózini rawajlandırıw úqiplılıǵına, óz-ózini bahalawına,

baqlawına, alǵan bilimlerin dóretiwshilik penen qollanıwına baylanıslı. Bul

aytılganlarǵa mashina programması juwap bere aladi.

Elektron kúndelik. Internet texnologiyasınıń rawajlanıwı mektepte elektron

"Kúndelіk" sistemasınıń engiziliwine úlken jańalıq  boldı. Bul sisteması menen

jumıs islew bilimlendiriwdiń aldıǵa rawajlanıwınıń áhmiyetli ózegi boldı.Sistemanı
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mektepte tolıq isletiw ushın Internettіń tezligin asırıw, hárbіr oqıwshınıń "Kúndelіk"

sistemasında jeke kabinetі bolıwı, bіraq hárbіr mektepte usı sistemanıń  jumısına

kerekli sekundına 4 megabit tezlikdegi internet texnologiyası talap etiledi.Sistemanı

iske qosıp, paydalanıdıń máqseti:

– muǵallіmlerdі qaǵaz toltırıw "azaplarınan" qutqarıw;

- mektepte sanlı tálim berıw sistemasın  qáliplestiriw;

-sistema altı jastan asqan balalar menen ata-analarǵa arnalǵan. Yaǵnıy, qosımsha

bіlіm beretuǵın kurslar, universitetter haqqında, mektep hám taǵı basqada

bilimlendiriw mekemeleri boyınsha málimleme usınıwǵa mólsherlengen.

Bul máqsetti orınlaw ushın elektron kúndelіkke ótiw zaman talabı

esaplanadı.Sistemanı proektlestiriw ushın mámleket tárepinen hárejet ajıratılıwı

kerek. Hárejetti qaplaw boljaw boyınsha 11 jıl ishinde qaytarıladı.

Sistemanı paydalanıw, muǵalımniń, oqıwshınıń, ata-ananıń jeke kabinetіnde iske

asırıladı. Bunıń ushın  "Kúndelіk" sistemasınıń ishinde maǵlıwmatlar bazasın

proektlestiriw kerek. Mektep adminstratorlıǵі’ klastaǵı oqıwshılardıń sanın, atı-

familiyaların hám ata-analardıń atı-familiyaları menen  birge basqada

maǵlıwmatlardı usınıw kerek. Bul jumıs klass basshılarınıń járdemi menen

orınlanadı. Alınǵan maǵlıwmatlar "Kúndelіk" sistemasınıń bazasına kiritiledi.

Paydalanıwshılar anıqlanǵannan soń, olarǵa  login men parol sóz beriledi.Login

menen parol sóz berilgennen soń, oqıwshı, ata-ana menen muǵallim sistemanıń

interfeysindegi "kіriw" knopkasın basıp, jumıs isleydi. Muǵallimniń  wazıypası –

baha qoyıw, úy tapsırmasın jazıw. Ata-ananıń wazıypası – balasınıń bahaların qarap,

sabaq kestesіmenen, úy tapsırması menen tanısıw. Al oqıwshınıń wazıypası –

sistemadan úy tapsırmasın qarap, onı orınlaw. Sonı aytiw  kerek, oqıwshı ózіnіń

bahaların hám ózі oqıytın klasstıń úy tapsırması menen sabaq kestesіn kóre aladı.

Informaciyalıq qáwipsizlikti  saqlaw harbir paydalaniwshınıń wazıypası

esaplanadı.Mekteptіń drayverі –muǵallim, sonlıqtan, statistikanı arttırıp, hámme

jańalıqtı oqıwshı men ata-anaǵa tezіrek úyretiw ushın eń aldımenen muǵalımniń

sharshaytını belgіlі. Bіr klasta kemіnde 25 oqıwshı bіlіm aladı desek, 25 oqıwshınıń
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hám 25 ata-ananıń maǵlıwmatların bazaǵa kiritiw ushın da bіrtalay waqıt ketedі. Bul

úlken hám juwapkershilikli jumıs.

Elektron tabel. Tabeldi toltırıw qaǵıydası tómendegishe alıp barıladı:

1. Tabeldiń dáslepki úlgi betine oqıwshınıń úlgeriwi hám minez hulqı ózi

oqıytuǵın tilde toltırıladı.

2. Klassta oqıtılatuǵın  pánler boyınsha oqıwshıǵa qoyılǵan jıllıq bahalar hám

minez hulqı qoyıladı.

3. Tabelge fakultativ, ellektiv kurslar ushın baha qoyılmaydı.

4. Klasstan klassqa  ótkeriw imtixanları “imtixan bahası” qatarına jazıladı.

5. Oqıwshınıń úlgeriwi hám minez hulqı harbir pán boyınsha 2, 3, 4, 5 bahalar

menen, attestacia bolmadı, bosatılǵan dep belgilenedi.

6. Eger oqıwshı oqıw saatınıń 75% in qaldırǵan bolsa,”attestacia bolmadı”

belgisi qoyıladı oqıwshı hám onıń ata-anası menen kelisken jaǵdayda.

7. Eger oqıwshınıń densawlıǵı haqqında medicinalıq spravkası bolsa, onda

fizikalıq tarbiya hám miynetke úyretiw pánlerineń. “bosatılǵan” belgisi

qoyıladı.

8. Shet tiller pániniń “Shet tiller” grafasına oqıtılǵan pánniń tili jazıladı: ingliz

tili, nemis tili, francuz tili, kitay tili h.t.b.

Tabeldi toltırıwda oqıw jılında oqıtılǵan pánlerdiń bahaları qoyıladı hám oqıw

jılınıń esabatı barlıq klasslar boyınsha hám mektep boyınsha jazıladı.

Úlgeriw esabatı boyınsha juwmaqlawshı vedomost. Esabat tayarlaw  klass

basshıları hám mekteptiń oqıw isleri direktorına tiyisli. Esabatta oqıwshılardıń

úlgeriwi haqqında klasslar boyınsha informaciya  jıynalǵan boladı hám

juwmaqlawshı tablica toltırıladı. Tablicada harbir oqıwshınıń pánlerden oqıw jılında

úlgeriwi, jıllıq bahası , imtixan bahası hám jurnaldaǵı juwmaqlawshı baha kiritiledi.

Multimedialı elektron oqıw resursların jaratıw barısında bilimdi bahalawda

mektepte isletiletuǵ ın tiykarǵı hyujjetler menen tanısıp, olardın’ strukturası analiz  islendi.

Mektepte multimedialı elektron oqıw resursların jaratıwdıń infologik modeli islendi.  Ol

tómende sıpatlap kórsetilgen:
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Multimedialı elektron oqıw resursların jaratıwdı proektlestiriwdiń Mazmunı

bóliminde programma ataması, orınlanatuǵın  ámeller(menyu qatarı), járdem beriw,

programma haqqında maǵlımat h.t.b.

Dasturiy támiyinlew bóliminde Microsoft office programmaları, ámeliy

programmalar, test jaratiw programmalar, animaciyalıq programmalar h.t.b.

paydalanıladı. Usı magistrlik dissertacia jumısın orınlaw barısında tómendegi

instrumental qurallardan paydalanıldı:  MS Word , Microsoft Power Point,

Microsoft Excel, Adobe Photoshop CS5, Microsoft Flash, Algoritmlik tiller(Delphi,

Paskal, h.t.b.).

Kompyuter grafikası bóliminde mektep hujjetlerine harturli kórinistegi bezew

jumısların orınlaytuǵın ámeliy dásturler, dásturiy paketler, ámelde paydalanıp

atırǵan texnologiyalar qollanıladı.

Proektlestiriw bóliminde mektepke tiyisli kiritiw hám shıǵarıw hujjetleri,

oqıwshılardıńism-sháripi, ana-analardińism-sháripi, til kesimindagi klasslar

ataması, oqıtılatuǵın panler ataması, oqıtıwshılardıńism-sháripi, oqıwshılardın’,

ana-analardıńhám  oqıtıwshılardıńjasaw mánzilleri, mektep strukturası h.t.b.

Qosımsha xızmetler bóliminde  servis xızmetler ámelge asırıladı. Oqıwshılar, ana-

analar hám  oqıtıwshılar haqqında maǵlıwmat tayarlaw, on-line rejiminde soraw-

juwap ámellerin orınlaw, bilim beriw sıpatın qadaǵalaw, oqıtıwshılardıń “qaǵaz”

jumısların azaytıwǵa járdemlesiw, aralıqtan oqıtıwdı támiyinlew, oqıwshılardı, ana-

analardı hám  oqıtıwshılardı sistemada islewge u’retiw h.t.b.

Mazmunı

Dasturiy támiyinlew

Kompyuter grafikası

Proektlestiriw

Multimedia elektron oqıw
resursların jaratıw metodikası

Qosımsha xızmetler
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Multimedialı elektron oqıw resursların jaratıw oqıtıw processin basqarıwdı

avtomatlastırıwǵa tiykar boladı. Avtomatlastırıw járdeminde oqıwshilardıńbilib

alıwı, kompyuter mádeniyatı, uqıplılıǵı, átirapqa kóz qarası, ilimge talpınıwı,

texnologiyaǵa  qızıǵıwshılıǵı artadı. Bul oqıtıwshılardıńbili beriw potenciyalın asırıǵa

alıp keledi.

III-BAP boyınsha juwmaqlaw

Bul bapta multimedia elektron oqıw resursların jaratıw metodikası qaraldı: 3D kitap

jaratıw algoritmin islep shıqtıq. Bilimdi bahalaw testleri jaratıldı. Elektron mektep

jaratıwda paydalanılatuǵın hujjetlerdi anıqladıq hám mekteptiń infologik modeli

proeklestirildi. Elektron mektep bazasında proeklestirilgen elektron dápter, elektron

tabel, elektron jurnal, elektron kúndelik  hujjetleriniń strukturası sıpatlandı hám

programmalıq támiyinleniwi kórsetildi.

Oqıwshılardıń bilimin bahalawda Ispring, EasyQuizy programmaları

qollanıldı. Bul programmalar 10 túrdegi test sorawların jaratıw múmkinshiligin

beredi. Delphi 10 lite vizual programmalastırıw tilinde test programmasın jaratıw

hám onıń islengen programmanı .exe formatında shıǵarıwı, bul tilde test jaratıw

programmasın jaratıw oǵada áhmiyetli bolıp tabıladı.
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Ulıwma juwmaqlaw

Rawajlanǵan mámleketlerde oqıtıwda  multimedia usılınan paydalanıw  házirgi

kúnde tálim tarawı jónelisleri boyınsha  engizilmekte. Tájriybe sonı kórsetpekte,

multimedia quralları tiykarında  oqıshılardı oqıtıw eki ese ónimli bolıwı menen birge

waqıttı hám tejew mumkin. Multimedia quralları tiykarında  bilim alǵanda  30% ge

shekem waqıttı tejew mumkin bolıp, alınǵan bilimler oqıwshılar yadında úzaq

múddetke saqlanıp qaladı.Sonı menen birge  oqıw materialların audio, video hám

grafika kórinisinde oqıwshılarǵa jetkerip bilim berilse, materiallardı yadda saqlaw

75% ge shekem  ósiwi tájiriybede dálellep kórsetilgen.  Mısal ushın shet tilin

multimedia quralları tiykarında  oqıwshılarǵa úyretiwdi aytıǵa boladı. Multimedia

quralları tiykarında  oqıtıw processinde anıq pándi kompyuter tiykarında tolıq

oqıtıw, lekciya tekstlerin redaktorlew, oqıwshılar tapsırǵan qadaǵlaw nátiyjeleriniń

analizi tiykarında   lekciya tekstlerin bayan etiwdi jaqsılaw, oqıshilar xabar

texnologiyalarını , multimedia quralları tiykarında  animaciya elementlerin sabaq

processinde kóriwi, esitiwi hám dodalaw imkaniyatlarına iye boladı. Sapalı

multimedia qosımshalarını islep shıǵıwǵa baǵdarlanǵan texnologik usıllar

magistrlik dissertatsiya jumısında sıpatlap berilgen.

Jumısta tiykarǵı jańalıq bolıp elektron kúndelik, elektron tabel, elektron tetrad

hám elektron jurnal jaratıw hám olardı ámelde paydalanıw metodikası qaraladı.

Bunıń ushın multimedia elektron oqıw resursların jergilikli jaǵday ushın

proektlestiriw hám qáliplestiriw texnologiyası  islep shıǵıldı.

Alınǵan nátiyjelerdiń ámeliy áhmiyeti mektep, kolledj, akademik litsey hám

joqarǵı oqıw orınları studentleri ushın, sonday-aq, ilimiy izleniwshiler, aspirantlar,

magistrler ushın multimedia elektron oqıw resursların jaratıw boyınsha metodikalıq

kórsetpe retinde paydalanıwǵa boladı. Aralıqtan bilim beretuǵın oqıw orınları,

oqıshılardıń bilim alıw sapasın, sabaqqa qatnasın, oqıw jılında úlgeriwin, oqiw

wazıpaların orınlaw dárejesin, baqlaw jumısların alıp barıdı, ata-nalardıń aralıqtan

oqıshı ballarınıń bilimin anıqlawın jetilistiriwge qollanıwǵa boladı.
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Usı magistrlik dissertatsiya jumısında joqarıda keltirilgen talaplardı

informatsiyalıq texnologiyalar bazasında multimedia elektron oqıw resursların

jaratıw metodikası qaraldı. Bul metodikanı jaratıw basqıshları tómendegilerden

ibarat boldı: Jumıs kirisiw, tiykarǵı úsh bólim hám qosımshadan  turadı.

Dissertatsiya jumısınıń birinshi basqıshı Multimedia hám onıń texnik-dasturiy

quralları atamasında bolıp, onda multimedia túsinigi, multimedia elektron oqıw

resursları, interaktiv tálim usılları kórip shıǵılǵan hám juwmaqlaw keltirilgen.

Ekinshi basqıshı Kompyuter grafikası hám  onıń túrleri atamasında bolıp,

tómendegi máseleler qaraldı:  Adobe Phoroshop dasturi hám onıń imkaniyatları ,

Rastrlı grafik redaktorında kórinis jaratıw hám olarǵa islew beriw,  Adobe

Photoshop dástúrinde reńler hám tekstler menen islew, Adobe Photoshop dástúrinde

kórnislerge qayta islew beriw, animaciya dasturleri hám onıń imkaniyatları, Adobe

Flash дастури hám onıń imkaniyatları, Delphi multimedia imkaniyatları qaraladı.

Bul programmalardan multimedia elektron oqıw resursların jaratıwda paydalaniw

uılları izertlenedi. Ekinshi bap boyınsha juwmaqlaw keltirilgen.

Magistrlik dissertatsiya jumısınıń úshinshi basqıshıMultimedia elektron oqıw

resursların jaratıw metodikası atamasında bolıp, bul jerde tómendegi máseleler

sheshildi:  3D kitap jaratıw, bilimdi bahalaw testlerin jaratıw, multimedia elektron

oqıw resursların jaratıwdı proektlestiriwge anıq mısallar sıpatlap berilgen.Úshinshi

bap sońında juwmaqlaw keltirilgen.

Magistrlik dissertatsiya jumısınıń ulıwma juwmaqlaw bóliminde hár  bir baptan

alınǵan nátiyjeler juwmaqlastırılǵan, soday-aq bul bólimde multimedia elektron

oqıw resursların jaratıw hám onı qollanıw keleshegi haqqında sóz etiledi.

Paydalanılǵan ádebiyatlar dizimi keltirilgen.

Magistrlik dissertatsiya jumısınıń qosımshalar bóliminde glossariy, kеуsler banki,

sabaq islenbe hám multimedia elektron oqıw resursların jaratıw ushın islep shıǵılǵan

programma listingi hám alınǵan nátiyjeler keltirilgen. Alınǵan nátiyjeler Nókis

qalasınıń Xalıq bilimlendiriw bólimine qaraslı №4 sanlı ulıwma bilim beriw

mektebiniń oqıwshıları ushın sınap kórildi.
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Magistrant Raxmetova Lazzat  2019 jıl 22-sentyabr kuni MS Excel de

formulalar jaratıw   hám MS Excel  di úyreniw boyınsha  online kursında oqıp

certifikat aldı.

Usı magistlik dissertatsiya jumısınıń nátiyjeleri Respublikalıq hám Xalıq aralıq

ilmiy – teoriyalıq konferenciyalarda dodalanǵan hám baspadan shıǵarılǵan[9-14].
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Qosımshalar

Delphi 10 lite visual programmalastırıw tilinde test jaratıwdıń tolıq
programma  kodı:

unit  Unit1;
interface
uses

Windows,  Messages,  SysUtils,  Variants,  Classes,  Graphics,  Controls,  Forms,
Dialogs,  ExtCtrls,  StdCtrls,  ComCtrls,  Buttons,  jpeg;

type
TForm1  =  class(TForm)

PageControl1:  TPageControl;
BitBtn1:  TBitBtn;
TabSheet1:  TTabSheet;
TabSheet2:  TTabSheet;
TabSheet3:  TTabSheet;
Label1:  TLabel;
Label2:  TLabel;
Image1:  TImage;
ScrollBox1:  TScrollBox;
RadioGroup1:  TRadioGroup;
RadioGroup2: TRadioGroup;
RadioGroup3:  TRadioGroup;
RadioGroup4:  TRadioGroup;
RadioGroup5:  TRadioGroup;
RadioGroup6:  TRadioGroup;
RadioGroup7:  TRadioGroup;
RadioGroup8:  TRadioGroup;
RadioGroup9:  TRadioGroup;
RadioGroup10:  TRadioGroup;
Label3:  TLabel;
Label4:  TLabel;
Button1:  TButton;
Image2:  TImage;
Label5:  TLabel;
Image3:  TImage;
procedure  BitBtn1Click(Sender:  TObject);
procedure  Button1Click(Sender:  TObject);
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private
{  Private  declarations  }

public
{  Public  declarations  }

end;
var
Form1:  TForm1;
ball:integer;
type  answers=array[1..10,0..3]  of  byte;
const juwap:answers=((0,1,0,0),(1,0,0,0),(0,0,0,1),(0,0,0,1),(1,0,0,0),(0,1,0,0),
(0,1,0,0),(0,0,0,1),(0,1,0,0),(1,0,0,0));
implementation
{$R  *.dfm}
procedure  TForm1.BitBtn1Click(Sender:  TObject);
begin
end;
procedure  TForm1.Button1Click(Sender:  TObject);
begin
ball:=juwap[1,radiogroup1.itemindex]+
juwap[2,radiogroup1.itemindex]+
juwap[3,radiogroup1.itemindex]+
juwap[4,radiogroup1.itemindex]+
juwap[5,radiogroup1.itemindex]+
juwap[6,radiogroup1.itemindex]+
juwap[7,radiogroup1.itemindex]+
juwap[8,radiogroup1.itemindex]+
juwap[9,radiogroup1.itemindex]+
juwap[10,radiogroup1.itemindex];
label3.caption:='10  sorawdan  '+inttostr(ball)+'sorawga  duris  juwap  berdiniz'
+'  qate  juwaplar  sanı  '+inttostr(10-ball);
if  (ball>8)  and  (ball<=10) then  label4.caption:='Sizin  bahaniz  "5"'
else  if  (ball>=7)  and  (ball<=8)  then  label4.caption:='Sizin  bahaniz  "4"'

else  if  ball=6  then  label4.caption:='Sizin  bahaniz  "3"'  else
label4.caption:='Sizin  bahaniz  "2"';

end;
end.
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Islep shıǵılǵan elektron hújjetler
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Internetten alınǵan materiyallar
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Glossariy

Elektron oqıw qollanba sabaqlıqtıń ayrım bólimlerin yamasa tolıq ornın
basıwshı, yamasa toltırıwshı hám qollanba sıpatında
oqıw orınları tárepinen tastıyıqlanǵan elektron ónim
bolıp esaplanadı

Installyaciya Komp’yuterge programmalıq támiyinleniw ornatıw

Intellektual- kitaplar mánisi jaǵınan ilgeri kirigizilgen imtixan alıwshı
kitaplarǵa jaqın hám oqıwshı qábiletlerıne onıń
menen gúrrińlesiw barısında jedel iykemlesiw
múmkin.

Interfeys (interface) Komp’yuter qurılmaların ózara sáykeslendiriw hám
baylanıs qurılmaları toplamı bolıp olardıń óz-ara
nátiyjeli islewin támiyinleydi

Kibernetik- kitaplar hám matematıkalıq modellestiriw quralların ózinde
saqlaydı hám sol sebepli bayan etilgen waqıyalar hám
ob`ektledı hár tárepleme úyreniw imkaniyatın
oqıwshıǵa usınıs etedi

Kompilyator programmanıń barlıǵın kodqa ótkeredi hám belgisiz
orınlanıwshı fayldı jaratadı (*.exe)

Multimedia- kitaplar bir seste(dawısta) (CD-ROM yaki magnit diskte)
jazılǵan hám bir sızıqda (tuwrı) shólkemlestirilgen,
yaǵnıy zárúr maǵlıwmat izbe-iz ráwishte súwretke
alınǵan tekst audio, statık kórinis hám videodan
paydalanıladı

Multimedia tekst, dawıslı maǵlıwmatlardı, tábiyiy hám grafikalıq
súwretlerdi birlestiriwshi informaciya texnologiyası

Programma kompyuter orınlawı kerek bolǵan buyrıq hám
kórsetpeleriniń izbe-izligi

Telemedia- kitaplar aralıqtan turıp oqıtatuǵın bólistiriwshı interaktiv
sistemanı qollap-quwatlaw ushın telekommunikaciya
imkaniyatlarınan paydalanadı
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Utilitalar (lat. – paydalı) Sistema programmalardıń bir bólegi
sıpatında járdemshi programmalar

Кomp’yuter animaciyası ekranda súwretlerdi “janlandırıw”, komp’yuterde
dinamikalıq súwretler sintezi
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